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Bio-Rad Resources
Bio-Rad provides many resources for scientists. Table 1 lists Bio-Rad resources and how to locate what 
you need.

Writing Conventions Used in this Manual
This manual explains how to safely set up and operate the MiniOpticon system. The manual uses the 
writing conventions listed in Table 2.

For information about safety labels used in this manual and on the MiniOpticon system, see, “Safety and 
Regulatory Compliance” on page iii.

Table 1. Bio-Rad resources 

Resource How to Contact

Local Bio-Rad Laboratories 
representatives

Find local information and contacts on the Bio-Rad website 
by selecting your country on the home page 
(www.bio-rad.com). Find the nearest international office 
listed on the back of this manual

Technical notes and literature Go to the Bio-Rad website (www.bio-rad.com) or Gene 
Expression Gateway (www.bio-rad.com/genomics/). Type a 
search term in the Search box and select Literature to find 
links to technical notes, manuals, and other literature

Technical specialists Bio-Rad’s Technical Support department is staffed with 
experienced scientists to provide customers with practical 
and expert solutions 

To find local technical support on the phone, contact your 
nearest Bio-Rad office. For technical support in the United 
States and Canada, call 1-800-424-6723 (toll-free phone), 
and select the technical support option

Table 2. Conventions used in this manual 

Convention Meaning

TIP: Provides helpful information and instructions, including information 
explained in further detail elsewhere in this manual

NOTE: Provides important information, including information explained in 
further detail elsewhere in this manual

WARNING! Explains very important information about something that might 
damage the researcher, damage an instrument, or cause data loss

X > Y Select X and then select Y from a toolbar, menu or software window
ii



MiniOpticon Manual
Safety and Regulatory Compliance
For safe operation of the MiniOpticon system, we strongly recommend that you follow the safety 
specifications listed in this section and throughout this manual.

Safety Warning Labels
Warning labels posted on the instrument and in this manual warn you about sources of injury or harm. 
Refer to Table 3 to review the meaning of each safety warning label. 

Instrument Safety Warnings
The warning labels shown in Table 4 also display on the instrument, and refer directly to the safe use of 
the MiniOpticon real-time PCR detection system.

Table 3. Meaning of safety warning labels 

CAUTION: Risk of danger! This symbol identifies components that pose a risk of personal 
injury or damage to the instrument if improperly handled. Wherever this symbol appears, 
consult the manual for further information before proceeding

CAUTION: Hot surface! This symbol identifies components that pose a risk of personal 
injury due to excessive heat if improperly handled

Table 4. Instrument Safety Warning Labels 

Icon Meaning

Warning about risk of harm to body or equipment.
Operating the MiniOpticon real-time PCR detection system before reading this manual can 
constitute a personal injury hazard. For safe use, do not operate this instrument in any 
manner unspecified in this manual. Only qualified laboratory personnel trained in the safe 
use of electrical equipment should operate this instrument. Always handle all components 
of the system with care, and with clean, dry hands

Warning about risk of burning. 
A thermal cycler generates enough heat to cause serious burns. Wear safety goggles or 
other eye protection at all times during operation. Always allow the sample block to return 
to idle temperature before opening the lid and removing samples. Always allow maximum 
clearance to avoid accidental skin burns

Warning about risk of explosion.
The sample blocks can become hot enough during the course of normal operation to cause 
liquids to boil and explode
iii



Safe Use Specifications and Compliance
Table 5 lists the safe use specifications for the MiniOpticon system. Shielded cables (supplied) must be 
used with this unit to ensure compliance with the Class A FCC limits.

REGULATORY COMPLIANCE

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesirable operation. 

This device has been tested and found to comply with the EMC standards for emissions and 
susceptibility established by the European Union at time of manufacture. 

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications. 

LE PRESENT APPAREIL NUMERIQUE N’EMET PAS DE BRUITS RADIOELEC¬TRIQUES DEPASSANT 
LES LIMITES APPLICABLES AUX APPAREILS NUMERIQUES DE CLASS A PRESCRITES DANS LE 
REGLEMENT SUR LE BROUILLAGE RADIOELECTRIQUE EDICTE PAR LE MINISTERE DES 
COMMUNICATIONS DU CANADA. 

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.

FCC WARNING

NOTE: Changes or modifications to this unit not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment. 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

Although this design of instrument has been tested and found to comply with Part 15, Subpart B of the 
FCC Rules for a Class A digital device, please note that this compliance is voluntary, for the instrument 
qualifies as an “Exempted device” under 47 CFR § 15.103(c), in regard to the cited FCC regulations in 
effect at the time of manufacture. 

Table 5. Safe Use Specifications 

Safe Use Requirements Specifications

Temperature Indoor use Ambient temperature of 15—31oC. Relative humidity 
maximum of 80% noncondensing

Altitude Up to 2,000 meters above sea level
iv
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 MiniOpticon Manual
1 System Installation
Read this chapter for information about setting up the MiniOpticon™ real-time PCR detection 
system:

• System overview (below)

• System requirements (page 3)

• Setting up the system (page 4)

• Installing CFX Manager™ software (page 4)

• Running experiments (page 8)

System Overview
The MiniOpticon system uses an array of 48 light-emitting diodes (LEDs) to sequentially 
illuminate each of the 48 wells in the cycler block. The LEDs efficiently excite fluorescent dyes 
with absorption spectra in the 470–505 nm range. The MiniOpticon system uses two filtered 
photodiodes for fluorescence detection. The first channel is optimized to detect dyes with 
emission spectra in the 523–543 nm range, such as SYBR® Green I and FAM. The second 
channel is optimized for dyes with emission spectra of 540–700 nm. The MiniOpticon detector 
is calibrated at the factory and requires no further calibration before use.

The MiniOpticon system includes: 

• Optical tower. This tower includes an optical system to collect fluorescent data 

NOTE: The serial number of the MiniOpticon system is located on a sticker on the 
back of the optical tower. 
1



System Installation
• MJ Mini thermal cycler base. The MiniOpticon system includes a thermal cycler block 
that rapidly heats and cools samples. 

Figure 1. Front view of the MiniOpticon system. 

When open, the MiniOpticon system includes these features:

• Inner lid with heater plate. The heater lid maintains temperature on the top of the 
reaction vessel to prevent sample evaporation. Avoid touching or otherwise 
contaminating the heater plate. Never poke anything through the holes, the apical 
system can be damaged.

• Block. Load samples in this block before the run

WARNING! Prevent contamination of the instrument by spills, and never run a 
reaction with an open or leaking sample lid. For information about general cleaning 
and maintenance of the instrument, see “Instrument Maintenance” (page 112).

WARNING! Avoid touching the inner lid or block: These surfaces can be hot.

The back panel of the MiniOpticon system includes these features (Figure 2):

• Power switch. Press the power switch to turn the power on

• Power input. Plug in the power cord here
2
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• USB connections. Use these ports to connect the MiniOpticon system to a computer

Figure 2. Back panel of MiniOpticon System.

WARNING! Avoid contact with the back panel during operation.

System Requirements
To operate the MiniOpticon system, use the following power sources and cables:

• Input power. 100—240 VAC, 50—60 Hz

• Indoor use. Ambient temperature of 15—31oC. Relative humidity maximum of 80% 
(non-condensing)

• Air Supply. The MiniOpticon system requires a constant supply of air that is 31°C or 
cooler in order to remove heat from the heat sink. Air is taken in from the lower vents 
located on the sides and front of the instrument and exhausted from the fan in the back. 
If the air supply is inadequate or too hot, the instrument can overheat, causing 
performance problems and even automatic shutdowns 

WARNING! Do not place the MiniOpticon system on a lab bench covered by bench 
paper. The bench paper can prohibit sufficient air circulation.

• USB cable. Control the MiniOpticon system using only the USB cable provided from 
Bio-Rad. This cable is sufficiently shielded to help prevent data loss
3



System Installation
Setting Up the system
The MiniOpticon system should be installed on a clean, dry, level surface with sufficient cool 
airflow to provide adequate air supply to run properly. The MiniOpticon system requires a 
location with power outlets to accommodate the MiniOpticon system and the computer. 

NOTE: Only one MiniOpticon system should be connected to a computer at 
one time.

Installing the MiniOpticon System
To install the MiniOpticon system:

1. Your MiniOpticon system shipment includes the components listed below. Remove all 
packing materials and store them for future use. If any items are missing or damaged, 
contact your local Bio-Rad office.
• MiniOpticon system
• USB cable
• CFX Manager software installation CD
• Instruction manual

• CFX ManagerTM software quick guides for protocol, plate, data analysis, and gene 
expression analysis

2. Firmly grasp the instrument from beneath to support the weight of the cycler and the 
optical tower. Carefully lift the instrument out of the shipping box. 

WARNING! Do not lift the instrument by the green handle. 

3. Insert the power cord plug into its jack at the back of the instrument. 

4. Plug the power cord into a standard 110 V or 220 V electrical outlet. The MiniOpticon 
system will accept 220 V automatically. Avoid plugging the MiniOpticon system into a 
power outlet that is already being used for other laboratory equipment

NOTE: Turn the system on only after installing CFX Manager software. The power 
switch is on the back right-hand side of the MiniOpticon system. 

Installing the CFX Manager Software
CFX Manager software is run on a PC computer with either the Windows XP or Windows Vista 
operating system and is required to run and analyze real-time PCR data from the MiniOpticon 
system. Table 6 lists the computer system requirements for the software on Windows XP and 
Windows Vista. 

Table 6. Computer requirements for CFX Manager software 

System Minimum Recommended

Operating system Windows XP Professional Service 
Pack 2 and above or Windows 
Vista Home Premium and above

Windows XP Professional SP2 and 
above or Windows Vista Home 
Premium and above

Drive CD-ROM drive CD-RW drive

Hard drive 10 GB 20 GB

Processor speed 2.0 GHz 2.0 GHz

RAM 1 GB RAM (2 GB for Windows 
Vista)

2 GB RAM 

Screen resolution 1024 x 768 with true-color mode 1280 x 1024 with true-color mode
4
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WARNING! Running a MiniOpticon system with CFX Manager software on a PC 
computer with a Windows 64-bit operating system is not supported due to 
incompatible USB drivers. A PC computer with a 64-bit processor (like Intel) on a 
32-bit Windows operating system is supported. 

WARNING! CFX Manager software can be installed on the same computer that 
already has Opticon Monitor version 3.1 installed. There may be conflicts 
controlling the instrument if both software packages are opened at the same time 
with the MiniOpticon turned on. 

WARNING! If the computer with the CFX Manager software is running a virus scan 
program, make sure scans are performed when the MiniOpticon system is idle.

To install the CFX Manager software:

1. Log in to the computer with administrative privileges, the software must be installed on 
the computer by a user with administrative privileges.

2. Place the CFX Manager software CD in the computer’s CD drive.

3. The software launch page should appear automatically. Double-click Install Software on 
the software launch page (Figure 3).

Figure 3. Software installation screen.

TIP: Click the Documentation button to find searchable PDF copies of instrument 
manuals and other documentation.

4. Accept the terms in the license agreement to continue.

5. Follow the instructions on the screen to complete the installation. When completed, the 
Bio-Rad CFX manager software icon will appear on the desktop of the computer.

USB USB 2.0 Hi-Speed port USB 2.0 Hi-Speed port

Internet browser Internet Explorer Internet Explorer 

Software Microsoft Office Suite

Table 6. Computer requirements for CFX Manager software  (continued)

System Minimum Recommended
5



System Installation
6. If the launch page does not appear automatically, double-click on (CD drive):\Bio-Rad 
CFX, then open and follow instructions in the Readme.txt file.

NOTE: For Windows Vista operating system, you will be prompted to install device 
software for Jungo during the CFX Manager software installation. Click Install to 
proceed. If prompted with the warning “Windows can’t verify the published of this 
driver software,” Click Install this driver software anyway to proceed.

Installing MiniOpticon System Drivers
The MiniOpticon system drivers must be installed on the computer in order to properly 
communicate with the device and perform real-time PCR experiments. The drivers are 
installed automatically during CFX Manager software installation for computers running 
Windows Vista operating system. Drivers must be installed manually for computers running 
Windows XP operating system. 

NOTE: For Windows XP operating system, three drivers must be installed: Bio-Rad 
Thermal Cycler (EEPROM Empty), Bio-Rad Mini Optical Module and Bio-Rad Mini 
Cycler. The driver installation package provides instructions on how to install the 
drivers correctly. 

To install the system drivers for Windows XP:

1. Connect the MiniOpticon system to the computer by plugging a USB cable (square end) 
into the USB 2.0 port located on the back of the MiniOpticon system, and then 
connecting the cable (flat end) into the USB 2.0 port located on the computer.

2. Turn the MiniOpticon system on by pressing the switch on the back of the system so that 
the side marked “I” is depressed. 

3. Follow the instructions in the Found New Hardware Wizard that launches after the 
instrument is first detected by the computer.

4. On the first screen, select Yes, this time only to instruct the Windows operating system 
to connect to Windows Update to search for software (Figure 4). Click Next. 

Figure 4. Found New Hardware Wizard.
6



MiniOpticon Manual
5. Select Install the software automatically to install the Bio-Rad Thermal Cycler 
(EEPROM Empty) driver. Click Next (Figure 5).

Figure 5. Software (Driver) installation screen.

6. A window will appear indicating the driver being installed has not passed Windows Logo 
testing to verify its compatibility with Windows XP. Click Continue Anyway to proceed.

7. Click Finish at the software installation completion screen when the driver is installed.

Figure 6. Finished Driver installation screen.

8. Repeat the driver installation for the Bio-Rad Mini Optical Module and the Bio-Rad 
MiniCycler drivers.
7



System Installation
Running Experiments 
Be sure that the MiniOpticon system is connected to the computer and turned on before 
launching the CFX Manager software. The green protocol-indicator light on the front of the 
MiniOpticon detector is illuminated only during a protocol run. 

WARNING! Remove the shipping plate from the thermal cycler block to operate.

Loading the Block
1. To access the MiniOpticon system’s block, turn the front green handle counter-clockwise 

until it snaps into the open position. Rotate the entire tower outward, to the left. 

2. Place the 48-well, 0.2 ml microplate, or tube strips with sealed lids in the block. Check 
that the tubes are completely sealed to prevent leakage. For optimal results, load sample 
volumes of 15–30 μl.

3. To ensure uniform heating and cooling of samples, sample vessels must be in complete 
contact with the sample holder. Adequate contact is ensured by: 
• Verifying the sample holder is clean before loading samples 
• Firmly pressing tubes, or a 48-well microplate into the sample holder

TIP: Spin down reactions in tubes or microplates before loading into the thermal 
cycler block. Air bubbles in samples, or liquid on the plate deck, can affect results. 

• Bio-Rad strongly recommends that oil not be used to thermally couple sample 
vessels to the block 

NOTE: Do not open the MiniOpticon detector while the green protocol-indicator 
light is illuminated. Opening the door, particularly during a scan of the plate, may 
interrupt the software’s control of the protocol. 

4. To close the instrument, rotate the tower back into the closed position and then turn the 
green handle clockwise (Figure 1). Both the tower and the handle have spring 
mechanisms that facilitate closure. 

NOTE: For accurate data analysis, check that the orientation of reactions in the 
block is exactly the same as the orientation of the well contents in the software 
Plate tab (see “Plate Tab” on page 19). If needed, edit the well contents before, 
during, or after the run. 

WARNING! When running the MiniOpticon system, always balance the tube strips 
or cut microplates in the wells. For example, if you run one tube strip on the left 
side of the block, run an empty tube strip (with caps) on the right side of the block 
to balance the pressure applied by the heated lid.

WARNING! Be sure that nothing is blocking the lid when it closes. Although there 
is a safety mechanism to prevent the lid from closing if it senses an obstruction, do 
not place anything in the way of the closing lid.

Recommended Plastic Consumables
Run only white-welled 48-well plates or white-welled strip tubes in the MiniOpticon system. 
For optimal results, Bio-Rad provides the following consumables for the MiniOpticon system 
(catalog numbers are provided in bold):

• MLL-4851. Multiplate low-profile 48-well unskirted PCR plates, white color wells

• TLS-0851. Low-profile 8-tube strips, 0.2 ml, without caps, white color wells

• TCS-0803. Optical flat 8-cap strips, for 0.2 ml tubes and plates, ultraclear
8
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2 Introduction to CFX Manager 
Software
Read this chapter for information about getting started with CFX Manager software.

• Main software window (below)

• Startup Wizard (page 13)

• Detected Instruments pane (page 14)

• Instrument Properties window (page 15)

• Software files (page 16)

• Software help tools (page 16)

Main Software Window
For instructions about running the system, refer to one of the quick guides that ship with the 
system:

• Protocol quick guide

• Plate quick guide

• Data Analysis quick guide

• Gene Expression Analysis quick guide

TIP: See the software Help for more guides about running experiments.

Get started in the main software window by using these features (Figure 7):

• Status bar. View the current software and instrument status (page 10)

• Menu bar. Select software commands to create or open files(page 10)

• Toolbar buttons. Open software files (page 12), the Startup Wizard (page 15), and the 
Experiment Setup window (page 17)

• Detected Instruments pane. View a list of attached instruments (page 13)
9



Introduction to CFX Manager Software
• Startup Wizard window. Access common software commands (page 14)

Figure 7. The main software window.

Status Bar
The status bar at the bottom of the main software window shows the status of the software. 
View the left side of the status bar (Figure 8) to see the current status of instruments.

Figure 8. Left side of status bar in main software window.

View the right side of the status bar (Figure 9) to see the current user name, date, and time.

Figure 9. Right side of status bar in the main software window.

Click and drag the right corner of the status bar to resize the main window.

Menu Bar
The menu bar of the main software window provides the items listed in Figure 10. 

Figure 10. Menu bar in the main software window.
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Select the commands shown in the menu bar (Table 7).

Table 7. Menu bar items in the main software window 

Menu Item Command Function

File New Create a new protocol, plate, experiment, or Gene 
Study

Open Open existing files, including protocol (.prcl), plate 
(.pltd), data (.pcrd), and Gene Study (.mgxd) files, 
and stand-alone run files (.zpcr)

Recent Data Files View a list of the ten most recently viewed data 
files, and select one to open in Data Analysis 

Repeat an Experiment Open the Experiment Setup window with the 
protocol and plate from a completed run to quickly 
repeat the run

Exit Exit the software program

View Application Log Display the application log for the software

Run Reports Select a run report to review from a list

Startup Wizard Open the Startup Wizard

Experiment Setup Open the Experiment Setup window

Instrument Summary Open the Instrument Summary window

Detected Instruments Show or hide the Detected Instruments pane

Toolbar Show or hide the main software window toolbar 

Status Bar Show or hide the main software window status bar

User Select User Open the Select User window to change software 
users

Change Password Change your user password

User Preferences Open the User Preferences window

User Administration Manage users in the User Administration window

Tools Dye Calibration Wizard Open the Dye Calibration window to calibrate an 
instrument for a new fluorophore

Protocol AutoWriter Open the Protocol AutoWriter window to create a 
new protocol

Ta Calculator Open the Ta Calculator window to calculate the 
annealing temperature of primers

View Block Status Log View a log of the thermal cycler block

Application Data Folder Open the Application Data folder to view software 
files

User Data Folder Open the Data folder to view protocol, plate, and 
data files

Properties All 
Instruments

View properties of all detected instruments, 
including serial numbers

Zip Data and Log Files Choose and condense selected files in a zipped 
file for storage or to email

Options Configure software email settings
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Toolbar Buttons
Click a button in the toolbar of the main software window (Table 8) for quick access to 
common software commands.

NOTE: To show or hide the toolbar, select View > Toolbar in the menu bar.

Windows Cascade Arrange software windows on top of each other

Tile Vertical Arrange software windows from top to bottom

Tile Horizontal Arrange software windows from right to left

Close All Close all open software windows

Help Contents Open the software Help for more information 
about running PCR and real-time PCR

Index View the index in the software Help

Search Search the software Help

Gene Expression 
Gateway Web site

Open a web site to find information about running 
PCR and real-time PCR experiments

PCR Reagents Website View a website that lists Bio-Rad consumables for 
PCR and real-time PCR reagents

PCR Plastic 
Consumables Website

View a website that lists Bio-Rad consumables for 
PCR and real-time PCR experiments

Software Updates Check for software updates from Bio-Rad 

About Open a window to see the software version

Table 8. Toolbar buttons in the main software window 

Button Button Name Function

Open a Data File Open a browser window to locate a data file (*.pcrd 
extension) and open it in the Data Analysis window 
(page 49)

Open a Gene Study Open a browser window to locate a Gene Study file 
(.mgxd extension) and open it in the Gene Study 
window (page 79)

Create a New Gene 
Study

Open the Gene Study window (page 79) to add files 
and create a new study

Print Print the current software window

Startup Wizard Open the Startup Wizard that links you to common 
software functions (page 14)

Table 7. Menu bar items in the main software window  (continued)

Menu Item Command Function
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Startup Wizard
The Startup Wizard automatically appears when CFX Manager software is first opened 
(Figure 11). If it is not shown, click the Startup Wizard button on the main window toolbar.

Figure 11. Startup Wizard window.

NOTE: Make sure you select MiniOpticon from the instrument pull-down menu.

Options in the Startup Wizard include the following:

Experiment Setup Open the Experiment Setup window to run an 
experiment (page 17)

Protocol AutoWriter Open the Protocol AutoWriter window to create a new 
protocol (page 33)

Select User Open the Select User window to change software 
users (see “Logging in and Selecting a User” on 
page 101)

User Preferences Open the User Preferences window (page 101)

Help Open the software Help window for more information 
about running PCR and real-time PCR

Table 8. Toolbar buttons in the main software window  (continued)

Button Button Name Function
13



Introduction to CFX Manager Software
• Create a new Experiment (page 17). Set up the protocol and plate to begin a new 
experiment. 

NOTE: Select the appropriate instrument in the pull down list to make sure the 
default plate settings match the instrument to be used for the experiment.

• Repeat an Experiment. Set up an experiment with the protocol and plate from a 
completed run. If needed, you can edit the experiment before the run

• Open a Data File (page 49). Open a data file to analyze results

• Open a Gene Study (page 79). Open a multi-file gene expression study to analyze 
results from multiple gene expression experiments

• Open User Preferences (page 101). Open the User Preferences window to customize 
software settings

Detected Instruments Pane
A connected MiniOpticon system will appear in the Detected Instruments pane, which shows 
each instrument as an icon named with the MiniOpticon serial number. 

Figure 12 shows detected MiniOpticon system with serial number 002481.

Figure 12. Instruments listed at the top of the Detected Instruments pane.

Right-click on the instrument icon to select one of these options:

• View Status. Open the Run Details window to check the status of the selected 
instrument block

• Properties. Open the Instrument Properties window

• Collapse All. Collapse the list of instruments in the Detected Instruments pane

• Expand All. Expand the list of instruments in the Detected Instruments pane

You can also control a block by clicking the View Status button in the Selected Instrument 
pane to launch the Run Details window (Figure 13).

Figure 13. View Status button at the bottom of the Detected Instruments pane.
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Instrument Properties Window
To open the Instrument Properties window to view information about an instrument, right-click 
on the instrument icon in the Detected Instruments pane (Figure 12). The window includes two 
tabs (Figure 14):

• Properties. View serial numbers of the MiniOpticon system

• Calibrated Dyes. View the list of calibrated fluorophores 

Figure 14. Instrument Properties window.

Properties Tab
The Properties tab displays important serial numbers for the connected instrument. The 
firmware versions are also displayed. The default name for an instrument is the MiniOpticon 
serial number, which appears in many locations in the software. 

Calibrated Dyes Tab
Open the Calibrated Dyes tab to view the list of calibrated fluorophores and plates for the 
selected instrument. Click an Info button to see detailed information about a calibration. 

Figure 15. Calibrated Dyes tab in the Instrument Properties window.
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Software Files
CFX Manager software stores information about experiments in specific files (Table 9):

Software Help Tools
The Help option of the CFX Manager software provides the following tools:

• Select the Search or Index tabs in this Help site to search for more information

• Open the Glossary to look up words that are specifically used in this software. For 
widely used words, consult a PCR dictionary or glossary

• Press F1 on your keyboard to open software help about topics in many of the 
software windows

• Print any Help page by right-clicking on it and selecting Print

Tips and Tricks
Tips and tricks for using CFX Manager software are listed below.

• Open any Protocol, Plate, Data, or Gene Study file by dragging it from a folder to an 
open software window

• Print or export the information shown in many windows by right-clicking a chart, 
spreadsheet, or well selector

• Change the size of any window by clicking and dragging the edges

• Open the User Preferences window to choose default settings that activate every 
time you log in to the software

• Add data files to a Gene Study by dragging from a folder to an open Gene Study 
window

• Open multiple Data Analysis and Gene Study files at the same time

• Click the Settings or Tools menu to find advanced functions 

• To add or delete files from the Express Load menu, add or delete the files (.prcl and 
.pltd extensions) in the ExpressLoad folder, select Tools > User Data Folder in the 
menu bar of the main software window

• To view all the information loaded into one well in a plate, double-click the well to 
open the Well Info window

• Right-click any graph or chart to change viewing and data analysis options

• Edit well contents before, during, or after the run

• Select a well group to view and analyze a subset of the wells in the plate. Select each 
well group by name in the Well Group pull-down menu in the toolbar

Table 9. File types used with CFX Manager software 

File Type Extension How to View and Edit File

Protocol .prcl Select in Experiment Setup and edit in Protocol Editor

Plate .pltd Select in Experiment Setup and edit in Plate Editor

Data .pcrd View and analyze in Data Analysis window

Gene Study .mgxd View and analyze in Gene Study window
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3 Running Experiments
Read this chapter for information about running experiments using CFX Manager software:

• Experiment Setup window (below)

• Protocol tab (page 18)

• Plate tab (page 19)

• Start Run tab (page 20)

• Run Details window (page 22)

• Instrument Summary Window (page 24)

Experiment Setup Window
The Experiment Setup window provides quick access to the files and settings needed to set 
up and run an experiment. To open the Experiment Setup window, follow one of these options: 

• Click the Create a New Experiment option in the Startup Wizard (page 14)

NOTE: Make sure you have MiniOpticon selected in the instrument pull down menu

• Click the Experiment Setup button in the main software toolbar (page 12)

• Select File > New > Experiment in the main software menu bar (page 10)

The Experiment Setup window includes three tabs:

• Protocol. Click the Protocol tab to select an existing protocol to run or edit, or to create 
a new protocol in the Protocol Editor window (page 27)

• Plate. Click the Plate tab to select an existing plate to run or edit, or to create a new 
plate in the Plate Editor window (page 37) 

• Start Run. Click the Start Run tab (page 20) to check the run settings, select one or 
more instrument blocks, and begin the run

NOTE: If the protocol currently selected in the Protocol tab does not include a step 
with a plate read for real-time PCR analysis, then the Plate tab is hidden. To view 
the Plate tab, add a “Plate Read” (page 30) in at least one step in the protocol.

NOTE: Start a new experiment from a previous run by selecting File > Repeat an 
Experiment in the main software menu bar. Then select the data file (.pcrd) for the 
experiment you want to repeat.
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The Experiment Setup window opens with the Protocol tab in front (Figure 16). To open 
another tab, click that tab or click Prev and Next at the bottom of the window.

Figure 16. Experiment Setup window, including the Protocol, Plate, and Start Run tabs.

Protocol Tab
The Protocol tab shows a preview of the selected protocol file loaded in the Experiment Setup 
(Figure 16). A protocol file contains the instructions for the instrument temperature steps, as 
well as instrument options that control the ramp rate and lid temperature. 

Select one of the following options to select an existing protocol, create a new protocol, or edit 
the currently selected protocol:

• Create New. Open the Protocol Editor to create a new protocol

• Select Existing. Open a browser window to select and load an existing protocol file 
(.prcl extension) into the Protocol tab

• Express Load pull-down menu. Quickly select a protocol to load it into the Protocol tab

TIP: To add or delete protocols in the Express Load menu, add or delete files (.prcl 
extension) in the ExpressLoad folder. To locate this folder, select Tools > User 
Data Folder in the menu bar of the main software window

• Edit Selected. Open the currently selected protocol in the Protocol Editor

End Point Only Runs
To run a protocol that contains only an end point data acquisition step, select Options > End 
Point Only Run from Options in the menu bar of the Experiment Setup window. The default 
end point protocol, which includes two cycles of 60.0°C for 30 seconds, is loaded into the 
Protocol tab. 
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Figure 17 shows the default end point protocol.

Figure 17. End Point Only protocol.

To change the step temperature or sample volume for the end point only run, click the Start 
Run tab and edit the Step Temperature or Sample Volume. Figure 18 shows the step 

temperature is changed to 55.0oC.

Figure 18. Change the sample volume on the Start Run tab.

Plate Tab
The Plate tab shows a preview of the selected plate file loaded in the Experiment Setup 
window (Figure 19). In a real-time PCR experiment, the plate file contains a description of the 
contents of each well, the scan mode, and the plate type. CFX Manager software uses these 
descriptions for data collection and analysis.

Select one of the following options to select an existing plate, create a new plate, or edit the 
currently selected plate:

• Create New button. Open the Plate Editor to create a new plate

• Select Existing button. Open a browser window to select and load an existing plate file 
(.pltd extension) into the Plate tab

• Express Load pull-down menu. Quickly select a plate to load it into the Plate tab

TIP: To add or delete plates in the Express Load menu, add or delete files (.pltd 
extension) in the ExpressLoad folder. To locate this folder, select Tools > User 
Data Folder in the menu bar of the main software window.
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• Edit Selected button. Open the currently selected plate in the Plate Editor 

Figure 19. Plate tab window.

Start Run Tab
The Start Run tab (Figure 20) includes a section for checking information about a run that is 
going to be started, including the selected protocol and plate files, and a section for selecting 
the instrument block.

• Run Information pane. View the selected Protocol file, Plate file, and data acquisition 
Scan Mode setting. Enter optional notes about the experiment in the Notes box

• Start Run on Selected Block(s) pane. Edit run parameters (if necessary), and then click 
the Start Run button to begin the experiment 

Figure 20. The Start Run tab.
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By default, the Start Run on Selected Block(s) pane shows the block name, block type, and 
status of the instrument detected by the software. These descriptions cannot be edited. 

NOTE: You can override the Sample Volume loaded in the Protocol file by selecting 
the volume in the spreadsheet cell and typing a new volume. 

NOTE: A Protocol ID can be entered for each block by selecting the cell and typing 
an ID or by selecting the cell and scanning with a bar code reader. 

To add or remove run parameters from the spreadsheet in the Start Run on Selected Block(s) 
pane, right-click on the list and select an option in the menu to display. Choose the value to 
change by clicking the text inside the cell to select it and then typing in the cell, or by selecting 
a new parameter from the pull-down menu. Editable parameters include:

• Lid Temperature. View the temperature of the lid. Override the lid temperature by 
selecting the text and typing a new temperature

Table 10 shows additional options on the right-click menu in the Start Run on Selected 
Block(s) pane:

Run Details Window
When you click Start Run, CFX Manager software prompts you to save the name of the data 
file and then opens the Run Details window (Figure 21). Review the information in this window 
to monitor the progress of a run.

• Run Status tab. Check the current status of the protocol, open the lid, pause a run, add 
repeats, skip steps, or stop the run

• Real-Time Status tab. View the real-time PCR fluorescence data as they are collected

Table 10. Start Run on Selected Block(s) right-click menu options 

Right-Click Option Function

Copy Copy selected text

Copy as Image Copy an image of the Start Run on Selected Block(s) pane

Print... Print the current view of the list of selected blocks

Print Selection... Print the column that is currently selected

Export to Excel... Export the list of blocks to an Excel spreadsheet file

Export to Text... Export the list of blocks to a text file

Find... Find text in the list of blocks

Sort... Sort up to three columns in the list of blocks
21



Running Experiments
• Time Status tab. View a full-screen countdown timer for the protocol

Figure 21. Run Details window.

Run Status Tab
The Run Status tab (Figure 21) shows the current status of a run in progress in the Run Details 
window and provides buttons to control the lid and change the run in progress. 

• Run Status pane. Displays the current progress of the protocol, including the current 
step, current GOTO repeat, block temperature, remaining hold time for the current step, 
sample temperature, lid and shuttle temperature

• Run Status buttons. Click one of the buttons to remotely operate the instrument or to 
interrupt the current protocol

• Run Information pane. Displays experiment details

Run Status Tab Buttons
Click one of the buttons listed in Table 11 to operate the instrument from the software, or to 
change the run that is in progress. 
NOTE: Changing the protocol during the run, such as adding repeats, does not change the 
protocol file associated with the run. These actions are recorded in the Run Log.

Table 11. Run Status buttons and their functions 

Button Function

This button is disabled for the MiniOpticon System

This button is disabled for the MiniOpticon system
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Real-Time Status Tab
The Real-time Status tab (Figure 22) shows real-time PCR data collected at each cycle during 
the protocol after the first two plate reads. This tab also shows the well selector and text 
describing the protocol status at the bottom of the window. 

TIP: Click View/Edit Plate to open the Plate Editor window. During the run, you 
can enter more information about the contents of each well in the plate.

Figure 22. The Real-time Status tab displays the data during a run.

Add more repeats to the current GOTO step in the protocol. 
This button is only available when a GOTO step is running

Skip the current step in the protocol. If you skip a GOTO step, 
the software verifies that you want to skip the entire GOTO 
loop and proceed to the next step in the protocol

Flash the run indicating LED on the MiniOpticon

Pause the protocol

NOTE: This action is recorded in the Run Log.

Resume a protocol that was paused

Stop the run before the protocols ends, which may alter your 
data

Table 11. Run Status buttons and their functions  (continued)

Button Function
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Replacing a Plate File
During a run, replace the plate file by clicking Replace Plate (Figure 22) in the Real-time 
Status tab. Select the new plate file (.pltd) from the list in the windows browser.

TIP: Replacing a plate file is especially useful if you start a run with a Quick Plate 
file in the Express Load folder. 

Time Status Tab
The Time Status tab shows a countdown timer for the current run (Figure 23).

Figure 23. The Time Status tab displays a count-down timer for the current run.

Instrument Summary Window
The Instrument Summary window shows the status of a detected instrument. Open this 
window by selecting View >Instrument Summary on the menu bar. Click the buttons in the 
tool bar to change the status of each instrument.

Figure 24. Instrument Summary window.

Instrument Summary Toolbar
The Instrument Summary toolbar includes buttons and functions listed in Table 12.

Table 12. Toolbar buttons in the Instrument Summary window 

Button Button Name Function

Set Up Experiment Set up an experiment on the selected 
block by opening the Experiment Setup 
window

Stop Stop the current run on selected blocks
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Right-Click Menu
Right-click in the Instrument Summary window to change the list of options that appear:

• Block Name. View the name of the block

• Type. View the size and type of the block

• Status. View the current status of the block

• User. View the current user who is logged in to the software

• Remaining. View the time remaining in the current run

• Copy. Copy the entire list

• Copy as Image. Copy the list as an image file

• Print. Print the list

• Print Selection. Print only the selected cells in the list

• Export to Excel. Export the list as an Excel formatted file

• Export to Text. Export the list as a text file

• Find. Find text in the list

• Sort. Sort the list by selecting up to three columns of data in the Sort window

Pause Pause the current run on selected blocks

Resume Resume the run on selected blocks

Flash Block Indicator Flash the run indicating LED on the 
MiniOpticon system

Open Lid This button is disabled for the 
MiniOpticon system

Close Lid This button is disabled for the 
MiniOpticon system

Hide Selected Blocks Hide the selected blocks in the 
Instrument Summary list

Show All Blocks Show the selected blocks in the 
Instrument Summary list

Show Select which blocks to show in the list. 
Select one of the options to show all 
detected blocks, all idle blocks, all the 
blocks that are running with the current 
user, or all running blocks

Table 12. Toolbar buttons in the Instrument Summary window  (continued)

Button Button Name Function
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4 Protocols
Read the following chapter for information about creating and editing protocol files:

• Protocol Editor window (below)

• Protocol Editor controls (page 29)

• Temperature control modes (page 33)

• Protocol AutoWriter (page 33)

Protocol Editor Window
A protocol instructs the instrument to control the temperature steps, lid temperature, and other 
instrument options. Open the Protocol Editor window to create a new protocol or to edit the 
protocol currently selected in the Protocol tab. Once a Protocol is created or edited in the 
Protocol Editor, click OK to load the protocol file into the Experiment Setup window and run it.

Opening the Protocol Editor
To open the Protocol Editor, follow one of these options:

• To create a new protocol, select File > New > Protocol or click Create New in the 
Protocol tab (page 18)

• To open an existing protocol, select File > Open > Protocol, or click Open Existing 
in the Protocol tab (page 18) 

• To edit the current protocol in the Protocol tab, click Edit Selected in the Protocol 
tab (page 18)

TIP: To change the default settings in the Protocol Editor window, enter the 
changes in the Protocol tab in the user Preferences window (page 104)

Protocol Editor Window Features
The Protocol Editor window (Figure 25) includes the following features:

• Menu bar. Select settings for the protocol

• Toolbar. Select options for editing the protocol

• Protocol. View the selected protocol in a graphic (top) and text (bottom) view. Click the 
temperature or dwell time in the graphic or text view of any step to enter a new value
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• Protocol Editor buttons. Edit the protocol by clicking one of the buttons to the left of 
the text view

Figure 25. Protocol Editor window with buttons for editing protocols.

Protocol Editor Menu Bar
The menu bar in the Protocol Editor window provides the menu items listed in Table 13.

The toolbar (Figure 26) in the Protocol Editor window provides quick access for important 
functions.

Figure 26. Protocol Editor toolbar.

Table 13. Protocol Editor menu bar 

Menu Item Command Function

File Save Save the current protocol

Save As Save the current protocol with a new name or in a new 
location

Close Close the Protocol Editor

Settings Lid Settings Open the Lid Settings window to change or set the Lid 
Temperature

Tools Gradient 
Calculator

Select the block type for a gradient step. Choose 48 Wells 
for the MiniOpticon system

Run-time 
Calculator

Select the instrument and scan mode to be used for 
calculating the estimated run time in the Experiment Setup 
window
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Table 14 lists the function of the Protocol Editor toolbar buttons. 

Protocol Editor Controls
The Protocol Editor window includes buttons for editing the protocol. First, select and highlight 
a step in the protocol by left clicking it with the mouse pointer. Then click one of the Protocol 
Editor buttons at the bottom left side of the Protocol Editor window to change the protocol. 
The location for inserting a new step is determined by the status of the Insert Step box located 
in the toolbar.

Inserting a Step
To insert a temperature step before or after the currently selected step:

1. Click Insert Step.

2. Edit the temperature or hold time by clicking the default value in the graphic or text view, 
and entering a new value.

Table 14. Protocol Editor toolbar buttons 

Toolbar Button and Menus Name Function

 

Save Save the current protocol file

 

Print Print the selected window

Insert Step Select After or Before to insert steps in a 
position relative to the currently highlighted 
step

Sample Volume Enter a sample volume in μl between 0 and 
50. If you are using higher than 50 μl 
reactions, select 50 μl. 
Sample volume determines the Temperature 
Control mode (page 33). Enter zero (0) to 
select Block mode

Run Time View an estimated run time based on the 
protocol steps and ramp rate

Help Open the software Help for more 
information about protocols
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3. (Optional) Click Step Options to enter an increment or extend option to the step 
(page 32). Figure 27 shows the new step that was inserted after step 2.

Figure 27. Protocol with inserted step.

Adding or Removing a Plate Read
To add a plate read to a step or to remove a plate read from a step:

1. Select the step by clicking the step in either the graphical or text view.

2. Click Add Plate Read to Step to add a plate read to the selected step. If the step 
already contains a plate read, the text on the button changes, so now the same button 
reads Remove Plate Read. Click to remove a plate read from the selected step.

In Figure 27, notice that the camera icon in the graphic view (top) shows that step 4 includes a 
plate read.

Inserting a Gradient
To insert a gradient step before or after the currently selected step:

1. Insert a temperature gradient step by clicking Insert Gradient. 

2. Make sure the plate size for the gradient matches the block type of the instrument. 
Select the plate size for the gradient by selecting Tools > Gradient Calculator in the 
Protocol Editor menu bar.

3. Edit the gradient temperature range by clicking the default temperature in the graphic or 
text view, and entering a new temperature. Alternatively, click the Step Options button to 
enter the gradient range in the Step Options window (page 32).

4. Edit the hold time by clicking the default time in the graphic or text view, and entering a 
new time.
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Figure 28 shows the inserted gradient step. The temperature of each row in the gradient is 
charted on the right side of the window.

Figure 28. Protocol with inserted gradient step.

Inserting a GOTO Step
To insert a GOTO step before or after the selected step:

1. Click Insert GOTO. 

2. Edit the GOTO step or number of GOTO repeats by clicking the default number in the 
graphic or text view, and entering a new value.

Figure 28 shows an inserted GOTO step at the end of the protocol. Notice that the GOTO loop 
includes steps 2 through 4. 

Inserting a Melt Curve
To insert a melt curve step before or after the selected step:

1. Click Insert Melt Curve.

2. Edit the melt temperature range or increment time by clicking the default number in the 
graphic or text view, and entering a new value. Alternatively, click Step Options to enter 
the gradient range in the Step Options window (page 32).

NOTE: You cannot insert a melt curve step inside a GOTO loop.

NOTE: The melt curve step includes a 30-second hold at the beginning of the step 
that is not shown in the protocol.
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Figure 29 shows a melt curve step added after step 6.

Figure 29. Protocol with inserted melt curve step.

Changing Step Options
To change a step option for the selected step:

1. Click on a step in the graphic or text view.

2. Click Step Options to open the Step Options window.

3. Add or remove options by entering a number, editing a number, or clicking a check box. 

TIP: To hold a step forever (an infinite hold), enter zero (0.00) for the time.

Figure 30 shows the selected step with a gradient of 10oC. Notice that some options are not 
available in a gradient step. A gradient step cannot include an increment or ramp rate change.

Figure 30. Step option for a gradient.

NOTE: A gradient runs with the lowest temperature in the front of the block (row H) 
and the highest temperature in the back of the block (row A).

The Step Options window lists the following options you can add or remove from steps:

• Plate Read. Check the box to include a plate read

• Temperature. Enter a target temperature for the selected step

• Gradient. Enter a gradient range for the step 
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• Increment. Enter a temperature to increment the selected step; the increment amount is 
added to the target temperature with each cycle

• Ramp Rate. Enter a rate for the selected step; the range depends on the block size

• Time. Enter a hold time for the selected step

• Extend. Enter a time to extend the selected step. The extend amount is added to the 
hold time with each cycle

• Beep. Check the box to include a beep at the end of the step

TIP: When you enter a number that is outside the option range, the software 
changes the number to the closest entry within the range.

Deleting a Step
To delete a step in the protocol:

1. Select a step in the graphic or text view.

2. Click Delete Step to delete the selected step.

WARNING! You cannot undo this function.

Temperature Control Modes
The instrument uses one of two temperature control modes to determine when the sample 
reaches the target temperature in a protocol. 

TIP: The sample volume can be changed before a run by editing the Sample 
Volume parameter in the Start Run tab (see “Start Run Tab” on page 20).

Enter a sample volume in the protocol editor to select a temperature control mode:

• Calculated mode. When you enter a sample volume between 1 and 50 μl the thermal 
cycler calculates the sample temperature based on the sample volume. This is the 
standard mode

• Block mode. When you enter a sample volume of zero (0) μl, the thermal cycler records 
the sample temperature as the same as the measured block temperature

Protocol AutoWriter
Open the Protocol AutoWriter to quickly write protocols for PCR and real-time PCR 
experiments. To open the Protocol AutoWriter, select one of these options:

• Click the Protocol AutoWriter button in the main software window toolbar

• Select Tools > Protocol AutoWriter from the menu bar in the main software window
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Figure 31 shows a protocol (bottom of window) written by the Protocol AutoWriter.

Figure 31. Protocol AutoWriter window with a new protocol.

Overview of the Protocol AutoWriter
The Protocol AutoWriter window uses information about your reaction to automatically 
generate a protocol file. Enter the following information about your PCR experiment:

• Annealing Temperature (Ta) or primer sequence. Enter the annealing temperature for 
the primers. If the annealing temperature is unknown, click Ta Calculator to enter the 
primer sequence so the Protocol AutoWriter calculates this value

• Amplicon Length (bp). Enter the expected length of the PCR product

• Enzyme. Select the DNA polymerase enzyme (iTaq, iProof, or Other) and enter 
additional information including hot start activation time, and final extension time

• Run time and type. Enter a speed (Standard, Fast, Ultrafast) to adjust the total run 
time, and select the type of PCR (Real-time PCR or PCR)

The run time for any protocol is influenced by the number of steps and cycles, the incubation 
time at each step, and the time it takes to reach uniformity at the target temperature. To reduce 
the overall run time, the Protocol AutoWriter makes one or more of the following changes:

• Reduces the total number of protocol steps

• Reduces the number of GOTO repeats

• Minimizes the hold time in each temperature step

• Minimizes the ramp time between steps by reducing the temperature change from 
one step to the next

For example, a typical PCR protocol includes the following three sets of steps with a total run 
time of 1.5 to 2.0 hours:

1. Initial template denaturation and enzyme activation (95°C for 3-10 minutes).
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2. Cycles of three temperature steps (30 to 40 cycles): Denaturation of template (94-95°C 
for 15-30 seconds), annealing of primers (anneal for 15-30 seconds), and extension of 
product (72°C for 15-60 seconds).

3. Final extension (72°C for 10 minutes).

The Protocol AutoWriter might make these modifications to shorten a typical protocol:

• Change the initial template denaturation and enzyme activation step from 95°C for 3 
minutes to 98°C for 30 seconds

• Change the denaturation step in each cycle from 95°C for 30 seconds to 92°C for 1 
second

• Combine the annealing and extension steps into a single step at 70°C for 20 
seconds

NOTE: Combining the annealing and extension steps imposes limits on the melting 
temperature of the primers. If the melting temperatures of the primers do not fall 
within the specified range, adjust the primers. For example, shorten the primers by 
2 to 3 bases (bp), or redesign them to adjust the melting temperature.

Creating a Protocol With the Protocol AutoWriter
Follow these steps to create a new protocol using the Protocol AutoWriter:

1. Click Protocol AutoWriter on the toolbar to open the Protocol AutoWriter window.

2. Enter the Annealing Temperature (Ta) and Amplicon Length in the boxes within the 
Enter Target Values/Enzymes pane. If you do not know the annealing temperature for 
primers, click Ta Calculator to enter the primer sequences and calculate the annealing 
temperature. For information about the calculations used in the Ta Calculator see 
Breslauer et al. 1986.

3. Select an enzyme type from the list of options (iTaq, iProof, or Other).

4. Add parameters in the Additional Parameters (Optional) pane if you want to add a 
Gradient Range, Hot Start Activation temperature, or Final Extension time in the 
protocol.

5. Select a protocol speed (Standard, Fast, or Ultrafast) by moving the sliding bar in the 
Type pane. When you move the sliding bar, the software adjusts the total run time. Select 
Real-time PCR to tell the software to collect fluorescence data.

6. Review the protocol and total run time in the Preview pane. Make changes as needed.

TIP: Enter the lid temperature and sample volume before each run by editing the 
parameters in the Start Run tab (see “Start Run Tab” on page 20).

7. Click OK to save the new protocol, or click Cancel to close the window without saving 
the protocol.

TIP: To edit a protocol written with the Protocol AutoWriter, open the protocol file 
(.prcl extension) in the Protocol Editor window (page 27).

NOTE: Bio-Rad Laboratories does not guarantee that running a protocol written in 
the Protocol AutoWriter window will always result in a PCR product.
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5 Plates
Read this chapter for information about creating and editing plate files:

• Plate Editor window (next section)

• Plate size and type (page 40)

• Select Fluorophores window (page 41)

• Well loading controls (page 42)

• Well Groups Manager window (page 46)

Plate Editor Window
A plate file contains run parameters such fluorophores and well contents, and instructs the 
instrument about how to analyze the data. Open the Plate Editor window to create a new plate 
or to edit the plate currently selected in the Plate tab. Once a plate file is created or edited in 
the Plate Editor, click OK to load the plate file into the Experiment Setup window and run it.

To run a real-time PCR experiment, you must load the minimal required information in the Plate 
Editor: at least one well must contain a loaded sample type and fluorophore.

TIP: You can change well contents before, during, and after running the 
experiment. However, the scan mode and plate size cannot be changed during or 
after the run.

Opening the Plate Editor
To open the Plate Editor window (Figure 32), follow one of these options:

• To create a new plate, select File > New > Plate or click the Create New button in 
the Plate tab (page 19)

• To open an existing plate, select File > Open > Plate, or click the Open Existing 
button in the Plate tab (page 19)

• To edit the current plate in the Plate tab, click the Edit Selected button in the Plate 
tab (page 19)

• To open the plate associated with a data file, in the Data Analysis window (page 49), 
click View/Edit Plate on the toolbar
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Figure 32. Plate Editor window.

Plate Editor Window Features
The Plate Editor window includes the following features:

• Menu bar.  Select settings for the plate size, plate type, number conventions, and units 
(page 38)

• Toolbar. Select settings for Well Groups (page 46) or open the Plate Loading Guide 
window for a quick overview of instructions to load a plate.

• Plate view. View the current well contents. Load wells by using the plate loading options 
on the right side of the plate view (Figure 32)

• Well loading controls. Choose the contents to load in the wells (page 42) from the 
controls on the right side of the plate view

The Plate Editor example shows some loaded wells with unknowns (Unk) and standards (Std) 
(Figure 32). The bottom of the plate lists the plate type (BR White) and a selector to view 
Target Name or Concentration when wells are loaded with a standard sample type. 

Plate Editor Menu Bar
The menu bar in the Plate Editor window provides the menu items shown in Table 15.

Table 15. Menu bar items in the Plate Editor 

Menu Item Command Function

File Save Save the plate files
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Plate Editor Toolbar
The toolbar in the Plate Editor provides quick access to important plate loading functions.

Figure 33. Plate Editor toolbar.

TIP: To change the default settings in the Plate Editor window, open the User 
Preferences window and enter the changes in the Plate tab.

Save As Save the plate file with a new file name

Exit Exit the Plate Editor

Settings Plate Size Select a plate size that reflects the number of wells in 
the instrument block. Choose 48 Wells for the 
MiniOpticon system
NOTE: Plate Size must be the same as the block size in 
the instrument on which the experiment will be run

Plate Type Choose the type of wells in the plate that holds your 
samples. The MiniOpticon system is only factory 
calibrated for BR White plates. For accurate data 
analysis, the plate type must be the same as the plate 
well type used in the experiment
NOTE: You must calibrate new plate types (page 111).

Number Convention Select or cancel the selection for Scientific Notation

Units Select the units to show in the spreadsheets when 
performing quantitation of unknowns versus a standard 
curve. Select copy number, fold dilution, micromoles, 
nanomoles, picomoles, femtomoles, attomoles, 
milligrams, micrograms, nanograms, picograms, 
femtomoles, attograms, or percent

Tools Show Spreadsheet 
View

Show the plate information in a spreadsheet view for 
export or printing

Plate Loading Guide Show a quick guide about how to set up a plate and 
load the wells 

Show Well Notes Select to show this pane in the well loading controls. 
Enter notes about one or more wells 

Show Collection 
Name

Select to show this pane in the well loading controls. 
Select to enter collection names for one or more wells

Help Help Contents Open the Help for more information about plates

Table 15. Menu bar items in the Plate Editor  (continued)

Menu Item Command Function
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Table 16 lists the functions available in the Plate Editor toolbar. 

Plate Loading Guide
Open the Plate Loading Guide window for information on how to load wells (Figure 34).

Figure 34. Plate Loading Guide window.

Plate Size and Type
The software applies these plate settings to all the wells during the experiment:

• Plate Size. Select a plate size that represents the size of the reaction module block of 
your instrument. Choose MiniOpticon from the pull-down menu option on the Startup 
Wizard to change the default plate size loaded in the Plate tab of the Experiment Settings 

Table 16. Toolbar items in the Plate Editor 

Toolbar Item Name Function

Save Save the current plate file

Print Print the selected window

Zoom Increase or decrease magnification in plate view

Well Groups Open the Well Groups Manager window and set up well 
groups for the current plate

Help Open the software Help for information about plates

Plate Loading 
Guide

Show a quick guide about how to set up a plate and load 
the wells 
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window. In the Plate Editor, select the plate size from the Settings menu (see Table 15). 
Plate size cannot be changed during or after the experiment

• Plate Type. For the MiniOpticon system, select the appropriate white wells designation 
from the Settings menu. For older systems, the plate type MJ White may need to be 
selected. For new systems, select the plate type BR White. Make sure the fluorophore 
being used in the experiment is calibrated for the selected plate type 

NOTE: The MiniOpticon system is factory calibrated for plates with white wells. 
Calibration is specific to the instrument, dye, and plate type. To calibrate a new 
combination of dye and plate type on an instrument, select Tools > Calibration 
Wizard (see “Calibration Wizard” on page 111).

Select Fluorophores Window
The Select Fluorophores window lists fluorophores that can be selected to load into the Plate 
Editor well loading controls. To open the Select Fluorophores window, click Select 
Fluorophores on the right side of the Plate Editor. 

NOTE: You cannot add or remove fluorophores in this list; you must calibrate the 
new fluorophores on an instrument in the Calibration Wizard (page 111). After 
calibration, the new fluorophore is added to the Select Fluorophore window.

NOTE: The MiniOpticon system is only factory calibrated for FAM, SYBR® and 
HEX. If you intend to use another dye, you must perform a dye calibration. To 
calibrate a new combination of dye and plate type on an instrument, select Tools > 
Calibration Wizard (see “Calibration Wizard” on page 111)

• Click the Selected check box next to the fluorophore name to add or remove a 
fluorophore that appears in the list on the right side of the Plate Editor window 
(Figure 35).

Figure 35. Select Fluorophores window.

• Click the Color box next to the fluorophore name and select a new color to represent 
each fluorophore in the Plate Editor window and Data Analysis charts

NOTE: Before beginning the run, the software verifies that the fluorophores you 
specified in the plate are calibrated on that instrument. You cannot run a plate if it 
includes fluorophores that have not been calibrated on that instrument.
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Well Loading Controls
A plate file contains information about the contents of each well loaded with sample for an 
experiment. After the run, the software links the well contents to the fluorescence data 
collected during the protocol and applies the appropriate analysis in the Data Analysis window. 
For example, wells loaded with a standard sample type are used to generate a standard curve. 

When setting up a gene expression experiment, consider the following guidelines for well 
contents:

• Target Name. One or more targets of interest (genes or sequences) in each loaded well. 
Each target is assigned to one fluorophore

• Sample Name. One identifier or condition that corresponds to the sample in each 
loaded well, such as “0 hr”, “1 hr”, or “2 hr”

TIP: Target names and sample names must match between wells to compare data 
in the Gene Expression tab in the Data Analysis window. Each name must contain 
the same punctuation and spacing. For example, “Actin” is not the same as 
“actin”, and “2hr” is not the same as “2 hr”. To facilitate consistency in names, 
enter them in the Target and Sample Names Libraries in the Plate tab in the User 
Preferences window (page 105).

Select a well to load contents into by left clicking with the mouse pointer in the plate view. 
Hold down the mouse button and drag to select multiple wells. The buttons and lists on the 
right side of the plate view include all the options needed to load the wells (Table 17).

Table 17. Options for loading the plate and wells in the Plate Editor 

Option Function

After selecting wells, the Sample Type must be loaded 
first. Select a Sample Type from the pull-down menu to 
load it in the selected wells. Sample Types include 
Unknown, Standard, NTC (no template control), Positive 
Control, Negative Control, and NRT (no reverse 
transcriptase)

Click a Load box to add a fluorophore to the selected 
wells; each fluorophore corresponds to a target name. To 
add fluorophores to the Load list, select them in the 
Select Fluorophores window 

For gene expression analysis or to distinguish between 
multiple targets, select a name in the Target Name pull- 
down menu and press Enter to load the target name in 
the well. To delete a target name, select it, press Delete, 
and then press Enter 

TIP: To add a new target name to the pull-down menu in 
the current plate only, type a name in the pull-down box 
and press Enter 
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For gene expression analysis or to distinguish between 
multiple samples, select a Sample Name from the pull-
down menu to load that sample name in the selected 
wells. To delete a sample name, select it in the menu, 
press the Delete key on your keyboard, and then press 
Enter.

TIP: To add a new sample name to the pull-down menu in 
the current plate, type a new name in the pull-down box 
and press the Enter key

To load replicate numbers, selected wells must contain 
identical well contents. If they do not, the software 
disables this loading control 
Click the Load box to add a Replicate # to the selected 
wells. Click Clear Replicate # to clear the replicate 
number from selected cells.

TIP: To load multiple replicate numbers across a series of 
wells, click the Replicate Series button.

In the Replicate Series pane you can apply a replicate 
series to a set of selected wells. Enter the Replicate 
Group Size by selecting a number from the pull-down 
menu that represents the number of samples (wells) in 
each group of replicates. Select a Starting Replicate # 
from the pull-down menu to add replicates.

NOTE: You can load replicate groups with replicate 
numbers progressing from left to right (Horizontal), or 
progressing from top to bottom (Vertical).

Enter a concentration to the selected wells with standard 
sample type by editing or typing a number in the 
Concentration box. To apply the concentration to one 
fluorophore in the well, select a single fluorophore from 
the pull-down menu (<All>) under the concentration 
box.To delete a concentration, select it, press Backspace 
on your keyboard and then press Enter

Select multiple wells with a Standard sample type to 
activate the Dilution Series button

Table 17. Options for loading the plate and wells in the Plate Editor  (continued)

Option Function
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Experiment Settings Window
To open the Experiment Settings window, follow one of these options:

• In the Plate Editor, click Experiment Settings

• While analyzing data in the Data Analysis window, click Experiment Settings in the 
Gene Expression tab

Open the Experiment Settings window to view or change the list of Targets and Samples 
(Figure 36 and Figure 37) or to set the gene expression analysis sample group to be analyzed if 
Collection Names have been added to the wells.

• Targets. A list of target names for each PCR reaction, such as a genes or sequences of 
interest. Click the Reference column to assign reference genes in an experiment

Click Dilution Series to enter a dilution series for the 
concentration of Standard samples, and load a standard 
curve

Enter the Starting Concentration for the dilution series, 
the Replicates from (starting replicate number) and to 
(ending replicate number), and the Dilution Factor 
(amount to change the concentration with each replicate 
group). Select Increasing for a dilution series that 
increases, or select Decreasing for a dilution series that 
decreases. Finally, select the fluorophore used for the 
dilution series from the pull-down menu and click Apply

Select Tools > Show Well Notes to show this pane. Enter 
notes about one or more wells by selecting the wells and 
typing the notes in the pull-down menu. Any notes you 
add appears in the spreadsheet on the Quantitation Data 
tab (page 58)

Select Tools > Show Collection Name to show this 
pane. Enter sample collection information about one or 
more wells by selecting the wells and typing a collection 
name in the pull-down menu. Any collection name you 
add to wells appear in the Gene Expression Analysis 
window and enables sample grouping options

Click Experiment Settings to open the Experiment 
Settings window to manage the lists of Targets and 
Samples, and to set up a gene expression experiment

Click Clear Replicate # to clear the replicates numbers in 
the selected wells

Click Clear Wells to clear all content in the selected wells

NOTE: Clicking Clear Wells permanently removes the 
content of the wells.

Table 17. Options for loading the plate and wells in the Plate Editor  (continued)

Option Function
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• Samples. A list of sample names that indicate the source of the target, such as a sample 
taken at 1 hour (1 hr), or taken from a specific individual (“mouse1”). Click the Control 
column to assign the control condition for an experiment

Figure 36 shows the Targets tab with the analysis settings shown.

Figure 36. Targets tab in Experiment Settings window.

Figure 37 shows the Samples tab with the Analysis Settings shown. 

Figure 37. Samples tab in Experiment Settings window.

To adjust the Targets and Samples lists, use the following functions:

• Add a target or sample name by typing a name in the New box, and clicking Add

• Remove a target or sample name from the list by clicking the Select to Remove box 
for that row, and then clicking Remove checked items(s) 

• Select the target as a reference for gene expression data analysis by clicking the box 
in the Reference column next to the name for that target 

• Select a control sample for gene expression data analysis by clicking the box in the 
Control column next to the name for that sample 
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Click the Show Analysis Settings box in the Experiment Settings window to view or change 
analysis parameters applied in the Gene Expression tab.

To adjust target parameters:

• Click a cell in the Color column to change the color of the targets graphed in the 
Gene Expression chart

• Enter a number for the efficiency of a target. The software calculates the relative 
efficiency for a target using Auto Efficiency if the data for a target includes a 
standard curve. Alternatively, type a previously determined efficiency

To adjust the settings for a sample in the Samples tab:

• Click a color in the Color column to change the color of the samples graphed in the 
Gene Expression chart

• Click a box in the Show Chart column to show the sample in the Gene Expression 
chart using a color that is selected in the Color column

Sample Name Grouping Option
Loading Collection Names in the wells enables samples to be analyzed in the Gene 
Expression data analysis tab using one of four configurations defined by the Sample Name 
Grouping Option. These options are available from the pull-down menu in the Experiment 
Settings tab. 

• Target vs. Sample

• Target vs. Collection

• Target vs. Sample_Collection

• Target vs. Collection_Sample

Well Groups Manager Window
Well groups divide a single plate into subsets of wells that can be analyzed independently in 
the Data Analysis window. Once well groups are set up, select a well group in the Data 
Analysis window to analyze the data in an independent group. For example, set up well groups 
to analyze multiple experiments run in one plate, or to analyze each well group with a different 
standard curve.

NOTE: The default well group is All Wells.

Create Well Groups
To create well groups in the Well Groups Manager window:

1. Click Well Groups in the toolbar of the Plate Editor.

2. Click Add to create a new group. The pull-down menu shows the group name as Group 
1 for the first group.

3. Select the wells that will compose the well group in the plate view by clicking and 
dragging across the group of wells. Selected wells turn blue in color (Figure 38). 

4. (Optional) Change the name of the group by selecting the group name in the pull-down 
menu and typing a new name.

5. (Optional) Create more well groups by repeating steps 1 and 2.
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6. (Optional) Delete well groups by selecting the group name in the pull-down list, and 
clicking Delete.

7. Click OK to finish and close the window, or click Cancel to close the window without 
making changes.

Figure 38. Color of wells in the Well Group Manager window.

Plate Spreadsheet View Window
The Plate Spreadsheet View window shows the contents of a plate in the Plate Editor. Open 
the Plate Spreadsheet View window (Figure 39) by selecting Tools > Show Spreadsheet View 
in the Plate Editor menu bar. 

Figure 39. Plate Spreadsheet View window.

Open the spreadsheet view to import or export the well contents to Excel or to another tab-
delimited format:

• Click Import Template to import well contents from a comma delimited file

• Click Export Template to export well contents in Excel file (.csv format)

To sort or edit a column, select it and use these methods:
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• Sort the spreadsheet according to the data in one column by clicking the diamond 
next to a column name

• Edit the contents of a column that has an asterisk (*) at the top by clicking and typing 
in each well

NOTE: Select the units for the standard curve data in the Quantity column by 
opening the Plate Editor and selecting Settings > Units in the menu bar. After the 
plate runs, the data from these standards appear in the Standard Curve chart of the 
Quantitation tab (Data Analysis window) with the units you select. Open the 
spreadsheet view to import or export the plate contents to Excel or another tab-
delimited format.

Right-click on the spreadsheet to select one of these options from the right-click menu:

• Copy. Copy the entire spreadsheet

• Copy as Image. Copy the spreadsheet as an image file

• Print. Print the spreadsheet

• Print Selection. Print only the selected cells

• Export to Excel. Export the file as an Excel formatted file

• Export to Text. Export the file as a text file

• Find. Find text in the spreadsheet

• Sort. Sort the spreadsheet by selecting up to three columns of data in the Sort window
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6 Data Analysis Overview
Read this chapter for information about data analysis:

• Data Analysis window (below)

• Quantitation tab (page 52)

• Well groups (page 53)

• Data analysis settings (page 53)

• Well selectors (page 55)

• Charts (page 58)

• Spreadsheets (page 58)

Data Analysis Window
During data analysis, changing the way the data are displayed by changing the contents of 
wells in the Plate Editor never changes the fluorescence data that were collected from each 
well during the run. Once the module collects fluorescence data, you cannot delete those 
data, but you can choose to remove data from view and analysis. 

To change the content of wells after a run, open the Plate Editor by clicking Edit/View Plate at 
the top of the Data Analysis window.

TIP: You can add or edit information about the contents of the well before, during, 
or after you run the real-time PCR experiment. You must assign the scan mode and 
plate size before the run, and these parameters cannot be changed after the run.

CFX Manager software processes real-time PCR data automatically at the end of each run, 
and opens the Data Analysis window to display these data. Choose one of these methods to 
open existing data files in the Data Analysis window:

• Drag a data file (.pcrd extension) over the main software window and release it

• Select File > Open > Data File in the main software window to select a file in the 
Windows browser

• Click Data Analysis in the main software window toolbar to select a file in the 
Windows browser

• Select File > Recent Data Files to select from a list of the ten most recently opened 
data files
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The Data Analysis window displays up to nine tabs (Figure 40). Each tab shows the analyzed 
data for a specific analysis method.

Figure 40. All the tabs that can be displayed in Data Analysis.

The software only displays a tab in the Data Analysis window if the data are collected in the 
run and data are available for that type of analysis. For example, the Melt Curve and Melt 
Curve Data tabs do not appear if the experiment does not include a melt curve step.

Data Analysis Toolbar
The toolbar in the Data Analysis window (Figure 41) provides quick access to important data 
analysis functions.

Figure 41. Toolbar in the Data Analysis window.

Table 18 lists the functions of buttons in the toolbar. 

Table 18. Toolbar in the Data Analysis window 

Toolbar button Name Function

 

Save Save the current data file

 

Print Print the selected window

 

Trace Style Open the Trace Style window

 

Report Open a Report for the current data file

 

View/Edit Plate Open the Plate Editor to view and edit the contents of 
the wells

 

Well Groups... Select a well group name from the pull-down menu. 
The default selection is All Wells

 

Help Open the software Help site for more information 
about data analysis
50



MiniOpticon Manual
Data Analysis Menu Bar
The menu bar in the Data Analysis window (Figure 42) provides these menu items:

Figure 42. Menu bar in the Data Analysis window.

Table 19 lists the functions of items in the menu bar. 

Table 19. Menu bar items in Data Analysis window 

Menu Item Command Function

File Save Save the file

Save As Save the file with a new name

Repeat Experiment Extract the protocol and plate file from the 
current experiment to rerun it

Exit Exit the Data Analysis window

View Run Log Open a Run Log window to view the run 
log of those data file

Settings Analysis Mode Select Baseline Subtraction method for 
the selected well groups in the data

C(t) Determination Mode Select Regression or Single-Threshold 
mode to determine how threshold-cycle 
(C(t)) values are calculated for each trace

Baseline Thresholds Open the Baseline Thresholds window to 
adjust the baseline or the threshold

Trace Styles Open the Trace Styles window

View/Edit Plate Open the Plate Editor to view and edit the 
plate

Mouse Highlighting Turn on or off the simultaneous 
highlighting of data with the mouse 
pointer

TIP: If Mouse Highlighting is turned off, 
then hold down the Control key to 
temporarily turn on the highlighting

Display Threshold Values Display the value of the threshold line in 
the chart

Tools Reports Open the Report for this data file

Import Fluorophore Calibration Select a calibration file to apply to the 
current data file

Replace Plate Replace the current plate file in the data 
analysis

Export All Data Sheets to Excel Export all the spreadsheet views from 
every tab to a separate Excel formatted 
file

Help Open software Help for more information 
about data analysis
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Quantitation Tab
Each tab in the Data Analysis window displays data in charts and spreadsheets for a specific 
analysis method, with a well selector to select the data you want to show. The Data Analysis 
window opens with the Quantitation tab (Figure 43) in front. The Amplification chart data in 
this tab should be used to determine the appropriate analysis settings for the experiment. 

NOTE: The Amplification chart shows the relative fluorescence units (RFU) for 
each well at every cycle. Each trace in the chart represents data from a single 
fluorophore in one well.

Figure 43. Layout of the Quantitation tab in the Data Analysis window.

NOTE: The software links the data in the panes of each data analysis tab. For 
example, highlighting a well by placing the mouse pointer over the well in the well 
selector view highlights the data in all the other panes.

Step Number Selector
The MiniOpticon system can acquire fluorescence data at multiple protocol steps; the 
software maintains the data acquired at each step independent. The software displays the 
Step Number selector below the Standard Curve chart on the Quantitation tab whenever a 
protocol contains more than one data collection step. When you select a step, the software 
applies that selection to all the data that are shown in the Data Analysis window. In Figure 44 
the data collection step number is 3 for all the data.

Figure 44. Step Number selection in the Data Analysis window.
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Viewing Well Groups the in Data Analysis Window

Wells in the plate can be grouped into subsets for independent analysis using well groups. 
When you create well groups in the Well Groups Manager window in the Plate Editor 
(page 46), group names appear in the Data Analysis window within the Well Groups list on the 
toolbar.

TIP: To open the Plate Editor, click View/Edit Plate in the Data Analysis window 
toolbar.

By default, All Wells is selected as the well group when the Data Analysis Window is first 
opened, with the data for all wells shown in the charts and spreadsheets.

Figure 45 shows Group 2 selected in the Well Groups menu. Only the wells in that well group 
appear loaded with content in the well selector and data only for these wells are included in 
the data analysis calculations. 

Figure 45. Data Analysis window with Group 2 selected.

Data Analysis Settings
The Amplification chart data in the Quantitation tab shows the RFU for each well at every 
cycle. Each trace in the chart represents data from a single fluorophore in one well. These data 
are used to determine C(t) values for each well on a per fluorophore basis. The software uses 
one of two modes to determine C(t) values:

• Regression. This mode applies a multivariable, nonlinear regression model to individual 
well traces and then uses this model to compute an optimal C(t) value

• Single Threshold. This mode uses a single threshold value to calculate the C(t) value 
based on the threshold crossing point of individual fluorescence traces 
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Adjusting the Threshold
In Single-Threshold mode, adjust the threshold for a fluorophore by clicking on the threshold 
line in the Amplification chart and moving the mouse pointer vertically. Alternatively, specify an 
exact crossing threshold for the selected fluorophore by following these instructions:

1. Select one fluorophore in the fluorophore selector in the Quantitation tab (Figure 43) by 
clicking the boxes next to the fluorophore name located under the Amplification chart.

2. Select Settings > Baseline Thresholds in the menu bar to open the Baseline Thresholds 
window.

3. Adjust the crossing threshold (Figure 46) for the fluorophore by clicking User Defined 
and entering a threshold number.

Figure 46. Baseline Thresholds window.

4. Click OK to confirm the change and close the window.

Baseline Settings
The software automatically sets the baseline individually for each well. Once you select the 
wells for analysis, check the baseline settings in these wells. Open the Baseline Thresholds 
window (Figure 46) to change the default baseline for selected wells. To open this window:

1. Select one fluorophore in the fluorophore selector in the Quantitation tab (Figure 43) by 
clicking the boxes next to the fluorophore name located under the Amplification chart.

2. Select Settings > Baseline Thresholds to open the Baseline Thresholds window.

To adjust the baseline begin and end cycle for each well:

1. In the Baseline Cycles pane, select one or more wells by clicking the row number, 
clicking the top left corner to select all wells, holding down the Control key to select 
multiple individual wells, or holding down the shift key to select multiple wells in a row.

2. Adjust the Baseline Begin cycle and Baseline End cycle for all selected wells or change 
the Begin and End cycle number at the bottom of the spreadsheet (Figure 46). 
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3. Click OK to confirm the change and close the window.

Selecting the Analysis Mode
Select the Analysis Mode to determine the method of baseline subtraction for all fluorescence 
traces. Select Settings > Analysis Mode to choose one of these three options:

• No Baseline Subtraction. The software displays the data as relative fluorescence 
traces. Some analysis is not possible in this analysis mode, and therefore the software 
does not display the Gene Expression, End Point, and Allelic Discrimination tabs

• Baseline Subtracted. The software displays the data as baseline subtracted traces for 
each fluorophore in a well. The software must baseline subtract the data to determine 
threshold cycles, construct standard curves, and determine the concentration of 
unknown samples. To generate a baseline subtracted trace, the software fits the best 
straight line through the recorded fluorescence of each well during the baseline cycles, 
and then subtracts the best fit data from the background subtracted data at each cycle

• Baseline Subtracted Curve Fit. The software displays the data as baseline subtracted 
traces, and the software smoothes the baseline subtracted curve using a centered mean 
filter. This process is performed so that each C(t) is left invariant

Well Selectors
Click the wells in the well selector to show or to hide the data in the charts or spreadsheets 
throughout the Data Analysis window:

• To hide one well, highlight and click the individual well. To show that well, highlight 
and click the well again

• To hide multiple wells, click and drag across the wells you want to select. To show 
those wells, click and drag across the wells again

• Click the top left corner of the plate to hide all the wells. Click the top left corner 
again to show all wells

• Click the start of a column or row to hide those wells. Click the column or row again 
to show the wells

Only wells loaded with content (entered in the Plate Editor) can be selected in the well selector, 
and their color shows if they are selected. As shown in Figure 47, the well selector shows 
these three types of wells:

• Selected, loaded wells (blue). These wells contain a loaded Unk (unknown) sample 
type. The data from these wells appear in the Data Analysis window

• Unselected, loaded wells (light gray). These wells contain loaded Std and Pos sample 
types. The data from unselected wells do not appear in the Data Analysis window
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• Empty wells (dark gray). These wells were not loaded in the Plate Editor window

Figure 47. Three well colors appear in a well selector.

Well Selector Right-Click Menu Items
Right-click any well selector view to select the items listed in Table 20.

Excluding Wells From Analysis

To exclude any wells from data analysis temporarily, follow these instructions:

RIGHT-CLICK OPTION

1. Right-click on the well in the well selector, on a fluorescence trace, or on a point plotted 
on the standard curve.

2. Choose Exclude Well XX from Analysis from the menu options. 

Figure 48. Exclude well XX from analysis.

Table 20. Right-click menu items in the well selectors 

Item Function

Copy Copy the content of the well to a clipboard, including Sample 
Type and optional Replicate #

Copy as Image Copy the well selector view as an image

Print... Print the well selector view

Print Selection... Print the current selection

Export to Excel... Export the data to an Excel spreadsheet
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NOTE: Unselect the Exclude Well from Analysis from the right-click menu to re-
include the well.

PLATE EDITOR OPTIONS

1. Click View/Edit Plate on the toolbar in the Data Analysis window. 

2. Select one or more wells in the well selector view.

3. Click Exclude Wells in Analysis (Figure 49) to exclude the selected wells. This checkbox 
is at the bottom of the Plate Editor controls on the right side of the window.

Figure 49. Click exclude Wells in Analysis checkbox at bottom of the pane.

In Figure 50, one well (under the pointer) was excluded from data analysis in the Plate Editor. 
Notice that the excluded well is grey and marked with an asterisk (*).

Figure 50. The excluded well is marked with * in the Plate Editor.

Alternatively, to permanently remove wells from analysis, clear the contents from wells in the 
Plate Editor by clicking Clear Wells. 

WARNING! You will have to reenter any well content that is cleared.
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Charts
Each chart in the Data Analysis window displays the data in a different graph and includes 
options for adjusting the data. To magnify an area of the chart, select the area by clicking and 
dragging the mouse. The software resizes the chart and centers it on the selected area.

TIP: Return the chart to a full view by right-clicking on the chart and selecting Set 
Scale to Default from the right-click menu.

Common Right-Click Menu Items for Charts
Right-click menu items are available on all charts. Some of the available items are present for 
all charts. These items can be used to change how the data are displayed or they can also be 
used to easily export the data from a chart (Table 21).

NOTE: Menu items that apply to specific charts are described in the next chapter 
“Data Analysis Windows” (page 61).

Spreadsheets
The spreadsheets shown in Data Analysis include options for sorting and transferring the data. 
Sort the columns by one of these methods:

• Click and drag a column to a new location in the selected table

• Click the column header to sort the data in ascending or descending order

To sort up to three columns of data in the Sort window, follow these steps:

1. Right-click on the spreadsheet to open the menu and select Sort.

2. In the Sort window, select the first column title to sort. Sort the data in ascending or 
descending order.

3. Select more than one column title by selecting the title in the pull-down menu. Select 
Ascending or Descending to sort the column in that order.

4. Click OK to sort the data, or click Cancel to stop sorting.

Table 21. Right-click menu items for charts 

Item Function

Copy Copy the chart into the clipboard

Save Image As... Save the chart image in the selected image file type. Select 
from these formats: PNG (default), GIF, JPG, TIF, or BMP

Page Setup... Preview and select page setup for printing

Print... Print the chart

Show Point Values Show the point values when the mouse moves over a point 
on the chart

Set Scale to Default Return to default chart view after magnifying the chart

Chart Options... Open the Chart Options window to change the chart title, 
select limits for the x- and y-axes, choose to show or hide 
showing grid lines, and choose to show or hide minor ticks 
in the axes
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Highlight the data on the associated charts and well selector by holding the mouse pointer 
over a cell. If you click in the cell, you can copy and paste the contents into another software 
program. 

Common Right-Click Menu Items for Spreadsheets
Right-click any spreadsheet view to select the items shown in Table 22. 

Table 22. Right-click menu items for spreadsheets 

Item Function

Copy Copy the contents of the selected wells to a clipboard. 
Then, paste the contents into a spreadsheet such as Excel

Copy as Image Copy the spreadsheet view as an image file and paste it 
into a file that accepts an image file such as text, image, or 
spreadsheet files

Print... Print the current view

Print Selection... Print the current selection

Export to Excel... Export the data to an Excel spreadsheet

Export to Text... Export the data to a text editor

Export to Xml Export the data to an XML file

Export to Html Export the data to an HRML file

Find... Search for text

Sort... Sort the data in up to three columns
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7 Data Analysis Windows
Read this chapter for more information about the tabs in the Data Analysis window:

• Quantitation tab (below)

• Quantitation Data tab (page 63)

• Melt Curve tab (page 66)

• Melt Curve Data tab (page 68)

• End Point tab (page 70)

• Allelic Discrimination tab (page 72)

• QC tab (page 72)

• Run Information tab (page 75)

• Data file reports (page 76)

Quantitation Tab
Use the data in the Quantitation tab (Figure 51) to set the data analysis conditions, including 
the baseline settings for individual wells and the threshold settings. The Quantitation tab 
shows data in these four views:

• Amplification chart. Shows the relative fluorescence units (RFUs) for each well at every 
cycle. Each trace in the chart represents data from a single fluorophore in one well 

NOTE: To select the fluorophore data to display or hide in the Quantitation tab 
charts and spreadsheets, click the fluorophore selector below the Amplification 
chart (Figure 51).

NOTE: Click the Log Scale box at the bottom of the Amplification chart to view the 
fluorescence traces in a semi-log scale

TIP: To magnify any area of the chart, click and drag the mouse across an area. To 
return to a full view, right-click and select Set Scale to Default from the menu.

• Standard curve. This graph is only shown if the experiment includes wells designated 
as a standard sample type. The standard curve is displayed with the threshold cycle 
plotted against the log of the starting quantity. The legend shows the Reaction Efficiency 
(E) for each fluorophore in the wells with a standard sample type

• Well selector. Selects the wells with the fluorescence data you want to show
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• Spreadsheet. Shows a spreadsheet of the data collected in the selected wells

Figure 51. Layout for the Quantitation tab in Data Analysis window.

Trace Styles Window
Open the Trace Styles window (Figure 52) to adjust the appearance of traces in the 
amplification and melt curve charts in the Quantitation and Melt Curve tabs.

To open this window, follow these steps:

1. Select only one fluorophore under the Amplification chart. 

2. Click Trace Styles in the Data Analysis toolbar, or select Settings > Trace Styles in the 
Data Analysis menu bar.

Figure 52. Trace Styles window.

Use the tools in the Trace Styles window to adjust appearance of traces, and preview the 
changes in the well selector at the bottom of the window.
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• Select a specific set of wells by using the well selector at the bottom of the window. 
Alternatively, select wells that contain one sample type in the pull-down menu in the 
Wells column, including Unknown, Standard, NTC (no template control), Positive 
Control, Negative Control, or NRT (no reverse transcriptase control) sample types

• Click the box in the Color column to select a color for the wells

• Select a symbol from the pull-down menu in the Symbol column

• Click Show Contents to show the sample types in each well, or click Show 
Symbols to show the selected Symbols in each well

• Click Remove Symbols to remove all the added symbols from all wells

• Click Restore Default Colors to return to the default trace colors

Standard Curve Chart
The software creates a Standard Curve chart (Figure 53) in the Quantitation tab if the data 
include sample types defined as standard (Std) for one fluorophore in the experiment.

Figure 53. Standard Curve chart.

The Standard Curve chart displays the following information:

• Name for each curve (the fluorophore name)

• Color of each fluorophore

• Reaction efficiency (E). Use this statistic to optimize a multiplex reaction, and 
equalize the data for a standard curve

NOTE: The reaction efficiency describes how much of your target is being 
produced with each cycle in the protocol. An efficiency of 100% means that you 
are doubling your target with each cycle.

• Coefficient of determination, R2 (written as R^2). Use this statistic to determine how 
correctly the line describes the data (goodness of fit)

Chart Right-Click Menu Options

In addition to the common right-click menu options to copy, print and export charts, Table 23 
lists the menu options available only on the Amplification chart.
Table 23. Amplification chart specific right-click menu options

Menu Option Function

Show Threshold Values Display the threshold value for each amplification curve on the 
chart
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Quantitation Tab Spreadsheet
Table 24 shows the type of data shown in the spreadsheet at the bottom right side of the 
Quantitation tab:

TIP: To make changes to the Content and Sample, open the Plate Editor by clicking 
View/Edit Plate.

Quantitation Data Tab
The Quantitation Data tab shows spreadsheets that describe the quantitation data collected in 
each well. Select one of the three options to show the data in different formats:

• Results. Displays a spreadsheet view of the data

• Plate. Displays a view of the data in each well as a plate map

• RFU. Choose this spreadsheet to show the RFU quantities in each well for each cycle

TIP: Right-click any spreadsheet for options, including the sort option. 

Results Spreadsheet
Select a Results spreadsheet (Figure 54) to see data for each well in the plate.

Figure 54. Quantitation Data tab with Results spreadsheet selected.

NOTE: All Std. Dev (standard deviation) calculations apply to the replicate groups 
assigned in the wells in the Plate Editor window. The calculations average the C(t) 
value for each well in the replicate group.

Trace Styles... Open the Trace Styles window to change trace styles that 
appear on the Quantitation and Melt Curve tabs

Baseline Thresholds... Open the Baseline Thresholds window to change baseline or 
thresholds of each fluorophore (changes appear in 
Amplification chart in Quantitation tab)

Table 24. Contents of the quantitation tab

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content A combination of the Sample Type (required) and Replicate # 
(optional) loaded in the Plate Editor

Sample Sample Name loaded in the Plate Editor wells

C(t) Threshold cycle for each trace
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The Results spreadsheet includes the type of information listed in Table 25. 

Plate Spreadsheet
Select the Plate spreadsheet to see a plate map of the data for one fluorophore at a time. 
Select each fluorophore by clicking a tab at the bottom of the spreadsheet. Figure 55 shows 
the Plate spreadsheet as plate map. 

Figure 55. Plate spreadsheet in Quantitation Data tab.

The Plate spreadsheet includes the type of information shown in Table 26, including the 
selected fluorophore in the plate map. 

Table 25. Contents of the results spreadsheet

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content Sample type and replicate number

Target Amplification target name (gene) 

Sample Sample description

Threshold Cycle (C(t)) Threshold cycle

C(t) Mean Mean of the threshold cycle for the replicate group

C(t) Std. Dev Standard deviation of the threshold cycle for the replicate group

Starting Quantity (SQ) Estimate of the starting quantity of the target

Log Starting Quantity Log of the starting quantity

SQ Mean Mean of the starting quantity

SQ Std. Dev Standard deviation of the starting quantity

Table 26. Contents of the plate spreadsheet

Information Description

Content Sample type and replicate number

Sample Sample description

Copy Number Starting number of targets in the sample

RFU Relative fluorescence units
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RFU Spreadsheet
Select the RFU spreadsheet to see the RFU readings for each well acquired at each cycle of 
the experiment. Select individual fluorophores by clicking a tab at the bottom of the 
spreadsheet. The well number appears at the top of each column, and the cycle number 
appears to the left of each row (Figure 56). 

Figure 56. RFU spreadsheet in the Quantitation Data tab.

The RFU spreadsheet includes the type of information shown in Table 27.

Melt Curve Tab
For DNA-binding dyes and noncleavable hybridization probes, the fluorescence is brightest 
when the two strands of DNA anneal. Therefore, as the temperature rises towards the melting 
temperature (Tm), fluorescence decreases at a constant rate (constant slope). At the Tm, there 
is a dramatic reduction in the fluorescence with a noticeable change in slope. The rate of this 
change is determined by plotting the negative first regression of fluorescence versus 
temperature (-d(RFU)/dT). The greatest rate of change in fluorescence results in visible peaks 
and represents the Tm of the double-stranded DNA complexes.

The software plots the RFU data collected during a melt curve as a function of temperature. To 
analyze melt peak data, the software assigns a beginning and ending temperature to each 
peak by moving the threshold bar. The floor of the peak area is specified by the position of the 
melt threshold bar. A valid peak must have a minimum height relative to the distance between 
the threshold bar and the height of the highest peak. 

Open the Melt Curve tab (Figure 57) to determine the Tm of amplified PCR products. This tab 
shows the melt curve data in these four views:

• Melt Curve. View the real-time data for each fluorophore as RFUs per temperature for 
each well

• Melt Peak. View the negative regression of the RFU data per temperature for each well 

• Well Selector. Select wells to show or hide the data

• Peak spreadsheet. View a spreadsheet of the data collected in the selected well

NOTE: This spreadsheet only shows as many as two peaks for each trace. To see 
more peaks, click the Melt Curve Data tab (page 68).

Table 27. Contents of the RFU spreadsheet

Information Description

Well number
(A2, A3, A4, A5, A6...)

Well data, listed by position in the plate for all the loaded wells

Cycle One round of denaturation, annealing, and extension, or one 
round of annealing and extension steps in a protocol
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Figure 57. Layout of the Melt Curve tab in the Data Analysis window.

Adjusting Melt Curve Data
Adjust the melt curve data by any of these methods:

• Click and drag the threshold bars in the Melt Peak chart to include or exclude peaks 
in data analysis

• Select Positive in the Peaks pull-down menu to show the spreadsheet data for the 
peaks above the Melt Threshold line, or select Negative to view the spreadsheet 
data for the peaks below the Melt Threshold line

• Open the Trace Styles window to change the color of the traces in Melt Curve and 
Melt Peak charts

• Select a number in the Step Number selector to view the Melt Curve data at another 
step in the protocol. The list shows more than one step if the protocol includes plate 
read (camera icon) in two or more melt curve steps

• Select wells in the well selector to focus on subsets of the data

• Select a well group (page 53) to view and analyze a subset of the wells in the plate. 
Select each well group by name in the Well Group pull-down menu in the toolbar

Melt Curve Tab Spreadsheet
Table 28 shows the type of information in the spreadsheet at the bottom right side of the Melt 
Curve tab. 

Table 28. Contents of the Melt Curve tab spreadsheet

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content A combination of Sample Type and Replicate # 

Sample Sample Name loaded in the Plate Editor

Melt Temp The temperature of the melt peak for each well. Only the two 
highest peaks are displayed in this spreadsheet.

Peak Height The highest point of the melt peak (-d(RFU)/dT)
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Melt Curve Data Tab
The Melt Curve Data tab shows multiple spreadsheets that include all the melt peaks for each 
trace. Select one of these four options to show the melt curve data in different spreadsheets:

• Melt Peaks. List all the data, including all the melt peaks, for each trace

• Plate. List a view of the data and contents of each well in the plate

• RFU. List the RFU quantities at each temperature for each well

• -d(RFU)/dT. List the negative rate of change in RFU as the temperature (T) changes. This 
is a first regression plot for each well in the plate

Melt Peaks Spreadsheet
Select Melt Peaks from the pull-down menu (Figure 58) to view melt curve data. 

Figure 58. Melt Peaks spreadsheet in Melt Curve Data tab.

The Melt Peaks spreadsheet (Figure 58) includes the type of information shown in Table 29. 

Table 29. Contents of the Melt Peaks spreadsheet

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content Sample Type listed in the Plate Editor window

Target Amplification target (gene)

Sample Sample Name listed in the Plate Editor window

Melt Temperature The melting temperature of each product, listed as one peak (highest) per 
row in the spreadsheet

Peak Height Height of the peak

Begin 
Temperature

Temperature at the beginning of the peak

End Temperature Temperature at the end of the peak
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Plate Spreadsheet
Select Plate from the pull-down menu (Figure 59) to view melt curve data in a plate format.

Figure 59. Plate spreadsheet in Melt Curve Data tab.

NOTE: To adjust the peak that the software calls, adjust the threshold line in the 
Melt Peak chart on the Melt Curve tab. 

The Plate spreadsheet includes the information shown in Table 30.

RFU Spreadsheet
Select RFU from the pull-down menu to view the fluorescence for each well at each cycle 
acquired during the melt curve (Figure 60).

Figure 60. RFU spreadsheet in Melt Curve Data tab.

Table 30. Contents of the Plate spreadsheet

Information Description

Content A combination of Sample Type (required) and Replicate # 
(optional)

Sample Sample description

Peak 1 First melt peak (highest)

Peak 2 Second (lower) melt peak
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Table 31 lists the type of information shown in the RFU spreadsheet. 

-d(RFU)/dT Spreadsheet
Select -d(RFU)/dT from the pull down menu to view the type of data shown in Figure 61.

Figure 61. The -d(RFU)/dT spreadsheet in the Melt Curve Data tab.

Table 32 lists the type of information shown in the -d(RFU)/dT spreadsheet. 

End Point Tab
Open the End Point tab to analyze final RFUs for the sample wells. The software compares the 
RFU levels for wells with unknown samples to the RFU levels for wells with negative controls, 
and “calls” the unknown as a Positive or Negative. Positive samples have an RFU value that is 
greater than the average RFU value of the negative controls plus the Cut Off Value.

To analyze the end point data, the plate must contain negative controls, or the software cannot 
make the call. Run one of these two types of protocols:

• Run a Quantitation protocol. Set up a standard protocol. After running the experiment, 
open the Data Analysis window, adjust the data analysis settings in the Quantitation tab, 
and then click the End Point tab to pick an end point cycle

• Run an End Point Only protocol.  Load the End Point Only protocol in the Plate tab of 
the Experiment Setup window, select or create a plate, and run the experiment

Table 31. RFU spreadsheet content

Information Description

Well number (A1, A2, A3, A4, 
A5...)

Well position in the plate for the loaded wells

Temperature Melting temperature of the amplified target. Plotted as one 
well per row, and multiple wells for multiple products in the 
same well

Table 32.  Contents of the -d(RFU)/dT spreadsheet 

Information Description

Well number (A1, A2, A3, A4, 
A5...)

Well position in the plate for the loaded wells

-d(RFU)/dT Negative rate of change in RFU as temperature (T) changes
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The End Point tab shows the average RFU values to determine whether or not the target was 
amplified by the last (end) cycle (Figure 62). Use these data to determine if a specific target 
sequence is present (positive) in a sample. Positive targets have higher RFU values than the 
cut off level you define. 

TIP: To create an end point protocol, open the Protocol tab (Experiment Setup 
window) and select Options > End Point Only Run.

The software displays these data in the End Point tab:

• Settings. Adjust data analysis settings

• Results. Shows the results immediately after you adjust the settings

• Well Selector. Select the wells with the end point data you want to show

• Well spreadsheet. Shows a spreadsheet of the end RFU collected in the selected wells

Figure 62. Layout of the End Point analysis tab.

The Results list includes this information:

• Lowest RFU value. Lowest RFU value in the data

• Highest RFU value. Highest RFU value in the data

• Negative Control Average. Average RFU for the wells that contain negative controls

• Cut Off Value. Calculated by adding the tolerance (RFU or Percentage of Range listed in 
the Settings) and the average of the negative controls. Samples with RFUs that are 
greater than the cut off value will be called “Positive”. To adjust the cut off value, change 
the RFU or Percentage of Range

The Cut Off Value is calculated using this formula:

Select a tolerance by one of these methods:

• RFUs (default). Select this method to use an absolute RFU value for the tolerance. The 
minimum RFU tolerance value is 2. The maximum is the absolute value of the highest 
RFU value minus the absolute value of the lowest RFU value. The default RFU tolerance 
value is 10% of the total RFU range

• Percent of Range. Select this method to use a percentage of the RFU range for the 
tolerance. The minimum percent of range is 1 percent. The maximum percent of range is 
99 percent. The default percent of range is 10 percent

Cut Off Value Negative Control Average Tolerance+=
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Adjusting the End Point Data Analysis
Adjust the information shown in the End Point tab by following these methods:

• Choose a Fluorophore from the pull-down list to view the data

• Choose an End Cycle to Average value to set the number of cycles that the 
software uses to calculate the average end point RFU

• Select RFUs to view the data in relative fluorescence units

• Select Percentage of Range to view the data as a percentage of the RFU range

• Select wells in the well selector to focus on subsets of the data

• Select a well group (page 53) to view and analyze a subset of the wells in the plate. 
Select each well group by name in the Well Group pull-down menu in the toolbar

Data Description for End Point Analysis
Table 33 list the type of information shown in the spreadsheet in the End Point tab.

Allelic Discrimination Tab
The Allelic Discrimination tab assigns the genotypes to wells with unknown samples using the 
RFU or C(t) of positive control samples (Figure 63). Use this data to identify samples with 
different genotypes, including Allele 1, Allele 2, Heterozygote, Unknown, Control 1, or Control 
2.

NOTE: The data for allelic discrimination must come from multiplex experiments 
with at least two fluorophores. Each fluorophore identifies one allele in all samples.

Allelic discrimination analysis requires the following minimal well contents:

• Two fluorophores in each well, except the wells that contain positive controls can 
contain only one fluorophore

• One fluorophore that is common to all wells in the well group

• NTC (no template control) samples if you want to normalize the data

The software displays allelic discrimination data in these layouts:

• RFU or C(t) chart. View the data in a graph of RFU or C(t) for Allele 1/Allele 2. Each point 
in the graph represents data from a single fluorophore in one well

• Well spreadsheet. Shows a spreadsheet listing the allelic discrimination data collected 
in each well of the plate

• Well selector. Select the wells with the end point data you want to show

Table 33. Contents of the End Point spreadsheet

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content A combination of the Sample type and Replicate #

End RFU RFU at the end point cycle

Call Positive or Negative, where positive samples have an RFU 
value greater than the average RFU of the negative controls 
plus the Cut Off Value

Sample Sample Name loaded in the Plate Editor
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• Well spreadsheet. Shows a spreadsheet listing the allelic discrimination data collected 
in the selected wells

Figure 63. Layout of the Allelic Discrimination tab in the Data Analysis window.

Adjusting Data for Allelic Discrimination
The software automatically assigns a genotype to wells with unknown samples based on the 
positions of the vertical and horizontal threshold bars, and then lists genotype calls in the 
spreadsheet view. To automatically call genotypes, the software uses positive controls (when 
available), or estimates the thresholds. The software takes an average C(t) or RFU for the 
positive controls to automatically set the threshold lines for discriminating the alleles. 

Adjust the position of the threshold bars by clicking and dragging them, and the software 
automatically adjusts the calculations to make new genotype assignments: 

• If the experiment contains three controls in the plate, then the position of the 
threshold bars is based on the mean and standard deviation of the RFU or C(t) of the 
controls

• If the number of controls is less than three, then the position of the threshold bars is 
determined by the range of RFU or threshold cycle values in the selected fluorophore

Adjust allelic discrimination data by following any of these methods:

• Click and drag the threshold bars in the Allelic Discrimination chart to adjust the calls 
in the spreadsheet

• Select a fluorophore for each axis in the chart (X: and Y:) in the settings options on 
the bottom right of the window
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• Change a call manually by highlighting a row in the spreadsheet, and then selecting 
an option in the Call Selected Alleles list (including Allele 1, Allele 2, Heterozygote, 
None, Unknown, Control 1, or Control 2)

• Click the Restore Default Thresholds button to restore the vertical and horizontal 
bars to their original position, which are indicated by the numbers next to the bars

• Select the C(t) Display Mode to view the data as threshold levels. Select RFU 
Display Mode to view the data in relative fluorescence units at the selected cycle

• Select Normalize Data to normalize the RFU data shown in the chart and 
spreadsheet 

Normalization changes the data on the chart to a range from 0 to 1 on both axes. To normalize 
the data, the plate must contain wells with “no template control” (NTC) sample types for both 
Allele 1 and Allele 2. For this plot, the RFU data are normalized to the NTC values as a linear 
combination of Allele 1- and Allele 2-specific RFUs. This plot is an effective way to present 
RFU data.

The calculations for normalized RFU follows the formulas presented in Livak et al. (1995).

Where:
• A1 represents RFU for Allele 1
• A2 represents RFU for Allele 2

•  represents the mean RFU
• NTCA1 + A2 represents the sum of RFUs for the NTC sample of Allele 1 and Allele 2

Allelic Discrimination tab Spreadsheet
The Allelic Discrimination spreadsheet at the top right side of the Allelic Discrimination tab 
shows the information shown in Table 34. 

QC Tab
Open the QC tab to quickly assess the quality of the experimental data based on the rules 
defined in the QC tab in the User Preferences window (see “QC Tab” on page 108).

The software displays QC information in these layouts (Figure 64).

Table 34. Contents of the Allelic Discrimination spreadsheet

Information Description

Well Well position in the plate

RFU1 or C(t)1 RFU or C(t) for Allele1

RFU2 or C(t)2 RFU or C(t) for Allele2

Call Identity of the allele, including automatic Allele 1, Allele 2, 
Heterozygote, None, Unknown, Control 1, Control 2

Type Auto (Automatic) or Manual. Describes the way the call was 
made. Automatic means the software selected the call. 
Manual means the call was chosen by the user

Normalized A1
A1

A1 A2 x NTCA1 A2+( )+ +
--------------------------------------------------------------=
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• Amplification chart. Shows the RFU for each well at every cycle. Each trace in the chart 
represents data from a single fluorophore in one well 

• QC rules. Shows the currently applied QC rules and the settings that define each rule

NOTE: You can turn on or turn off rules by clicking the check box next to the rule in 
the Use Rule column.

• Well selector. Selects the wells with the fluorescence data you want to show

• Rule Description. Shows the selected QC rule and highlights wells that fail the rule

Figure 64. QC tab layout.

Run Information Tab
The Run Information tab (Figure 65) shows the protocol and other information about the run for 
each experiment. Open this tab for the following options: 

• View the protocol

• Enter and edit the Notes. Enter or edit notes about the experiment and run by typing 
in the Notes box

• Enter and edit the data ID for the run by typing in the ID box
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• View the Other section to see events, such as error messages, that might have 
occurred during the run. View these messages to help troubleshoot a run 

Figure 65. Layout of the Run Information tab in the Data Analysis window.

Reports for Data Files
The Report window (Figure 66) shows information about the current data file in the Data 
Analysis window. To open a report, select Tools > Reports, or click the Reports button on the 
toolbar in the Data Analysis window.

The Report window shows these three sections:

• Menu and toolbar. Select options to format, save and print the report or template

• Options list (top, left side of window). Select options to show in the report

• Options pane (bottom, left side of window). Enter information about a selected option

• Preview pane (right side of window). View the current report in a preview

Figure 66. Example of a Report window for a data file.
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TIP: The layout of the report can define the type of information that appears in any 
report if you save the report as a template. Select Template > Save or Save As to 
save the layout of the current report as a template.

Creating a Data Analysis Report
To create a report in the Data Analysis window, follow these steps:

1. Make final adjustments to the well contents, selected wells, charts, and spreadsheets in 
the Data Analysis window before creating the report.

2. Click Report in the Data Analysis toolbar to open the Report window.

3. Change the options you want to include in the report. The report opens with default 
options selected. Click the check boxes in the report options list to change whole 
categories or individual options within a category. 

NOTE: The data that appear in the report are dependent on the current selections 
within the tabs of the Data Analysis window. For example, a quantitation 
experiment might not contain a standard curve, and therefore those data do not 
appear in the Data Analysis window or in the data report.

4. Click Update Report to update the Report Preview with any changes.

5. Print or save the report. Click Print in the toolbar to print the current report. Select File > 
Save to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft 
document), or MHTML (Microsoft document) formatted file and select a location to store 
the file. Select File > Save As to save the report with a new name or in a new location.

6. (Optional) Create a report template with the information you want. To save the current 
report settings in a template, select Template > Save or Save As. Then load the report 
template the next time you want to make a new report.

Data Analysis Report Categories
A report can include any of the options in each category described in Table 35, depending on 
the type of data in Data Analysis window. 

Table 35. Data analysis report categories in the options list

Category Option Description

Header Title, subtitle and logo for the report

Report Information Experiment date, user name, data file 
name, data file path, and selected well 
group

Notes Notes about the data report

Experiment Setup

Run Information Includes the experiment date, user, data 
file name, data file path, and the selected 
well group

Protocol Text view of the protocol steps and 
options

Plate Display Show a plate view of the information in 
each well of the plate
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Quantitation

Analysis Settings Includes the step number when data 
were collected, the analysis mode, and 
the baseline subtraction method

Amplification Chart Copy of the amplification chart for 
experiments that include quantitation 
data

Standard Curve Chart Copy of the standard curve chart

Data Spreadsheet listing the data in each well

Gene Expression

Analysis Settings Includes the analysis mode, chart data, 
scaling option, and chart error

Chart Copy of the gene expression chart

Target Names Chart of the names

Sample Names Chart of the names

Data Spreadsheet listing the data in each well

Melt Curve

Analysis Settings Includes the melt step number and 
threshold bar setting

Melt Curve Chart Copy of the melt curve chart

Melt Peak Chart Copy of the melt peak chart

Data Spreadsheet listing the data in each well

Allelic Discrimination

Analysis Settings Includes display mode, fluorophores, 
cycle, thresholds, and normalized data

Chart Copy of the allelic discrimination chart

Data Spreadsheet listing the data in each well

End Point

Analysis Settings Includes fluorophore, end cycles to 
average, mode, lowest RFU value, 
highest RFU value, and cut off value

Data Spreadsheet listing the data in each well

Table 35. Data analysis report categories in the options list (continued)

Category Option Description
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8 Gene Expression Analysis
Read this chapter for information about performing Gene Expression Analysis:

• Overview of Gene Expression Analysis (below)

• Plate setup for gene expression analysis (page 80)

• Gene Expression tab (page 80)

• Experiment Settings window (page 85)

• Performing a Gene Study (page 85)

• Gene Study Report window (page 92)

• Gene expression calculations (page 94)

Overview of Gene Expression Analysis
With the use of stringently qualified controls in your reactions, you can run a gene expression 
experiment to normalize the relative differences in a target concentration between samples. 
Typically, message levels for one or more reference genes are used to normalize the 
expression levels of a gene of interest. Reference genes take into account loading differences 
or other variations represented in each sample, and they should not be regulated in the 
biological system being studied.

Open the Gene Expression tab to evaluate relative differences between PCR reactions in two 
or more wells. For example, you can evaluate relative numbers of viral genomes, or relative 
number of transfected sequences in a PCR reaction. The most common application for gene 
expression study is the comparison of cDNA concentration in more than one reaction to 
estimate the levels of steady state messenger RNA.

The software calculates the relative expression level of a target with one of these scenarios: 

• Relative expression level of a target sequence (Target 1) relative to another target 
(Target 2). For example, the amount of one gene relative to another gene under the 
same sample treatment

• Relative expression level of one target sequence in one sample compared to the 
same target under different sample treatments. For example, the relative amount of 
one gene relative to itself under different temporal, geographical, or developmental 
conditions
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Plate Setup for Gene Expression Analysis
To perform gene expression analysis, the contents of the wells must include the following:

• Two or more targets. The two targets that represent different amplified genes or 
sequences in your samples

• One or more reference targets. At least one target must be a reference target for 
normalized expression. Assign all reference targets in the Experiment Settings window 
(page 44) to analyze the data in Normalized Expression mode (ΔΔC(t)). Experiments that 
do not contain a reference must be analyzed using Relative Expression mode (ΔC(t))

• Common samples. Your reactions must include common samples (minimum of two 
required) to view your data plotted in the Gene Expression tab. These samples represent 
different treatments or conditions for each of your target sequences. Assign a control 
sample (optional) in the Experiment Settings window (page 44)

The requirements for Gene Expression setup in the Plate Editor depend on whether reaction 
contents are singleplex PCR with one fluorophore in the reactions, or multiplex PCR with 
more than one fluorophore in the reactions.

Figure 67 shows an example of the minimum contents of the wells for a singleplex gene 
expression experiment. 

Figure 67. Example of well contents in a singleplex gene expression experiment.

Figure 68 shows an example of the minimum contents of the wells for a multiplex gene 
expression experiment. 

Figure 68. Example of well contents in a multiplex gene expression experiment.

Gene Expression Tab
The Gene Expression tab (Figure 69) in the Data Analysis window shows the relative 
expression of targets in these two views:

• Gene Expression chart. Shows the real-time PCR data as normalized expression 
(ΔΔC(t)) or relative quantity (ΔC(t))

• Spreadsheet. Shows a spreadsheet of the gene expression data

TIP: Right-click any chart or spreadsheet for options. Click View/Edit Plate to 
open the Plate Editor, and change well contents in the plate.
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.

Figure 69. Layout of the Gene Expression tab in the Data Analysis window.

TIP: Right-click on the chart to select right-click menu options. Select Sort from 
this menu to rearrange the order of the Target and Sample names in the chart.

Normalized Gene Expression

To normalize data use the measured expression level of one or more reference genes (targets) 
as a normalization factor. Reference genes are targets that are not regulated in the biological 
system being studied, such as actin, GAPDH, or histone H3.

To set up normalized gene expression (ΔΔC(t)) analysis, follow these steps:

1. Open a data file (.pcrd extension).

2. Review the data in the Quantitation tab of the Data Analysis window. Make adjustments 
to the data, such as changing the threshold and the Analysis Mode.

3. Click the Gene Expression tab.

4. Choose a control in the Samples tab of the Experiment Settings window. If a control is 
assigned, the software normalizes the relative quantities for all genes to the control 
quantity, which is set to 1.

5. Select reference genes for this experiment in the Target tab of the Experiment Settings 
window. Gene expression analysis requires one reference among the targets in your 
samples.

6. Select Normalized Expression (ΔΔC(t)) if it is not already selected, and then view the 
expression levels in the Gene Expression tab.
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Relative Quantity
By definition, relative quantity (ΔC(t)) data are not normalized. This method is used to 
quantitate samples that do not include any reference genes (targets). Typically, researchers are 
confident in one of the following considerations when they set up their experiment:

• Each sample represents the same amount of template in each biological sample, 
possibly the same mass of RNA or cDNA in each well

• Any variance in the amount of biological sample loaded is normalized after the run by 
some method in the data analysis outside of the software. For example, a researcher 
might choose to simply divide the relative quantity value by the normalizing factor, 
possibly the mass of nucleic acid loaded for each sample, or the number of cells 
from which the nucleic acid was isolated 

Select Relative Quantity (ΔC(t)) from the pull-down menu in the chart controls of the Gene 
Expression tab to run a Relative Quantity (ΔC(t)) analysis.

TIP: To compare results to data from other gene expression experiments, open a 
new Gene Study (page 90), or add a data file to an existing Gene Study.

Adjusting Gene Expression Data
After selecting your analysis method, adjust the data you view in the Gene Expression tab by 
changing the settings options to the right of the chart. 

GRAPH DATA

Graph data options allow you to present the data in the graph with one of these two options:

• Relative to control. Graph the data with the axis scaled from 0 to 1. If you assign a 
control in your experiment, select this option to quickly visualize upregulation and 
downregulation of the target

• Relative to zero. Graph the data with the origin at zero

X-AXIS OPTIONS

The x-axis option allows you to select the x-axis data of the Gene Expression graph:

• Target. Select this option to graph the target names on the x-axis

• Sample. Select this option to graph the sample names on the x-axis

Y-AXIS OPTIONS

The y-axis option allows you to show the Gene Expression graph in one of these three scales:

• Linear. Select this option to show a linear scale

• Log 2. Select this option to evaluate samples across a large dynamic range

• Log 10. Select this option to evaluate samples across a very large dynamic range

SCALING OPTIONS

Select Normalized Gene Expression (ΔΔC(t)) to activate the scaling options in the Gene 
Expression graph. Select one of these scaling options to calculate and present your data in a 
manner that best suits your experimental design:

• Unscaled expression. This option presents the unscaled normalized gene expression
82



MiniOpticon Manual
• Highest expression. Scale the normalized gene expression to the highest for each 
target by dividing the expression level of each sample by the highest level of expression 
in all the samples. This scaling option uses the scaled to highest formula

• Lowest expression. Recalculate the normalized gene expression for each target by 
dividing the expression level of each sample by the lowest level of expression in all the 
samples. This scaling option uses the scaled to lowest formula

ERROR TYPE

Select an option for the type of error calculations (error bars) in the Gene Expression graph:

• Standard Error of the Mean (default, SEMs)

• Standard Deviation (Std Devs)

CHART ERROR BAR MULTIPLIER

Select a multiplier for the error bars in the Gene Expression graph. Select one of these 
integers: +/- 1 (default), 2, or 3. The type of multiplier changes when you select the Error Type:

• SEMs for Standard Error of the Mean

• Std Devs for Standard Deviations

TARGET STABILITY VALUE

Open this window whenever more than 1 reference gene is used. The software calculates two 
quality parameters for the reference genes:

• Coefficient of Variation (CV) of normalized reference gene relative quantities. Lower 
CV values denotes higher stability

• M-value. A measure of the reference gene expression stability

Right-Click Menu Options for Gene Expression Graph
Right-click on the Gene Expression graph to select the items shown in Table 36. 

Table 36. Right-click menu items

Item Function

Copy Copy the chart to a clipboard

Save as Image Save the graph in the chart view as an image file. The default 
image type is PNG. The other selections for image file types 
include GIF, JPG, TIF, and BMP

Page Setup... Select a page setup for printing

Print... Print the chart view

Show Point Values Display the relative quantity of each point on the graph when 
you place the cursor over that point

Set Scale to Default Set the chart view back to the default settings after magnifying 
it

Chart Options... Open the Chart Options window to adjust the graph

Sort Sort the order that samples or targets appear on the x-axis

User Corrected Std Devs Calculate the error bars using the corrected standard deviation 
formula

Use Solid Bar Colors Display solid bars in the graph

x-axis labels Choose to display x-axis labels horizontal or angled
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Gene Expression Spreadsheet
Table 37 describes the information shown in the Gene Expression spreadsheet.

Show Details Option
When you click the Show Details check box, Table 38 also shows this information. 

Table 37. Description of information in the spreadsheet on the Gene Expression tab 

Information Description

Target Target Name (amplified gene) selected in the Experiment 
Settings window

Sample Sample Name selected in the Experiment Settings window

Ctrl Control sample, when the Sample Name is selected as a 
control in the Experiment Settings window

Expression Normalized Gene Expression (ΔΔC(t)) or Relative quantity 
(ΔC(t)) depending on the selected mode

Expression SEM (or SD) Standard Error of the Mean or Standard Deviation, depending 
on the selected option

Corrected Expression SEM 
(or SD)

Corrected value calculation for Standard Error of the Mean 
(SEM) or Standard Deviation (SD) of the relative expression, 
depending on the selected option

Mean (C(t)) Mean of the threshold cycle

C(t) SEM (or SD) Standard Error of the Mean or Standard Deviation of the 
threshold cycle, depending on the selected option

Table 38. Information in Gene Expression spreadsheet with Show Details selected 

Information Description

Data Set Fluorescence data from one fluorophore in the data file

Relative Quantity Calculated relative quantity of samples

Relative Quantity SD Standard deviation of the relative quantity calculation

Corrected Relative Quantity 
SD

Calculated standard deviation of the corrected relative 
quantity

Unscaled Expression Calculated unscaled expression

Unscaled Expression SD Calculated standard deviation unscaled expression

Corrected Unscaled 
Expression SD

Calculated standard deviation of the unscaled expression

Expression Relative expression level

Wells Well number in the plate
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Experiment Settings Window
Open the Experiment Settings window by clicking Experiment Settings in the Gene 
Expression tab. In this window, view or change the list of Targets and Samples, select 
reference genes, select control samples, or set the Gene Expression Analysis sample group to 
be analyzed if Collection Names have been added to the wells (Figure 70).

Figure 70. Experiment Settings window with Targets tab selected.

To adjust the lists in these tabs, use the following functions:

• Add a target or sample name by typing a name in the New box and clicking Add

• Remove a target or sample name from the list by clicking the Remove Name box for 
that row, and then clicking the Remove checked item(s) button

• Select the target as a reference for gene expression data analysis by clicking the box 
in the Reference column next to the Name for that target 

• Select the sample as a control sample for gene expression data analysis by clicking 
the box in the Control column next to the name for that sample

Sample Name Grouping Option

Loading Collection Names in the wells enables samples to be analyzed in one of four 
configurations defined by the Sample Name Grouping Option, providing an option to analyze 
samples based on biological replicates. For example, a study may include a time course 
analysis (0 hr, 1 hr, 2 hr, etc) across biological samples (mouse 1, mouse 2, mouse 3, etc.). 
Researchers may want to analyze results based on the time course, based on the biological 
samples or by a combination of the two.

These options are available from the pull-down menu in the Experiment Settings tab.

• Target vs. Sample. Only the well sample name is used in the gene expression 
calculations. In the results shown in Figure 71, only the sample name is used in the 
analysis (0 hr, 1 hr, 2 hr, etc)
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Figure 71. Target vs. Sample option results.

• Target vs. Collection. Only the well collection name is used in the calculations

• Target vs. Sample_Collection. The sample name and collection name are combined to 
make a single name that is used in the calculations. The end-result of this analysis is the 
separation of each sample name to include the collection name (

Figure 72. Target vs. Sample_Collection results.

• Target vs. Collection_Sample. The collection name and sample name are combined to 
make a single name that is used in the calculations

Show Analysis Settings in Experiment Settings
Click the Show Analysis Settings box in the Experiment Settings window to view or change 
analysis parameters applied in the Gene Expression tab:

• Click a cell in the Color column to change the color of the targets graphed in the 
Gene Expression chart

• Enter a number for the efficiency of a target. The software calculates relative 
efficiency for a target using Auto Efficiency if the data for a target includes a 
standard curve. Alternatively, type a previously determined efficiency
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Figure 73 shows the efficiency of all the targets, which appear if Auto Efficiency is selected. 

Figure 73. Targets tab in Experiment Settings with Show Analysis Settings selected.

To adjust the settings for a sample in the Samples tab:

• Click a color in the Color column to change the color of the samples graphed in the 
Gene Expression chart

• Click a box in the Show Chart column to show the sample in the Gene Expression 
chart using a color that is selected in the Color column

Figure 74 shows the samples with the Show Chart option selected. 

Figure 74. Samples tab in Experiment Settings with Show Analysis Settings selected.

Performing a Gene Study
Create a Gene Study to compare gene expression data from one or more real-time PCR 
experiments using an inter-run calibrator to normalize between the experiments. Create a 
Gene Study by adding data from one or more data files (.pcrd extension) to the Gene Study, 
the software groups them into a single file (.mgxd extension).

NOTE: The gene expression data must include a common sample in every data file 
to create a Gene Study. The software uses the common sample to normalize the 
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data between experiments. Select the sample names in the Experiment Settings 
window (page 44).

NOTE: The maximum number of samples you can analyze in a Gene Study is 
limited by the size of the computer's RAM and virtual memory.

Gene Study Inter-Run Calibration
All data within the Gene Study are normalized by inter-run calibrator to calculate the smallest 
average ΔC(t) value. When the data files within the Gene Study include more than one inter-run 
calibrator, then the calibrator with the smallest average ΔC(t) value becomes the dominant 
inter-run calibrator. The dominant calibrator is used to adjust all C(t) values in the Gene Study.

To find the dominant inter-run calibrator, the software calculates the average of the ΔC(t) 
values for all inter-run calibrators of a given target (gene), and then uses a multitiered algorithm 
to determine the dominant inter-run calibrator within all the data. The algorithm for finding the 
dominant inter-run calibrator includes the following hierarchy: 

1. Set the dominant calibrator to the target with the highest number of common replicate 
groups in a given pair-wise comparison. 

2. If any target has the same number of common replicate groups, then set the dominant 
calibrator to the target with the smallest range of ΔC(t) values in pair-wise comparisons. 
The range is examined by comparing the absolute value of the difference between the 
maximum and minimum ΔC(t) for the inter-run calibrators of a given target.

3. If any target has an identical range as the ΔC(t) values, set the dominant calibrator to the 
target with the smallest absolute value of average ΔC(t) for eligible inter-run calibrator 
samples.

4. If any target has identical average ΔC(t) absolute values, set the dominant calibrator to 
the replicate group with the smallest ΔC(t).

NOTE: The first data file imported into the Gene Study always serves as the “hub” 
file for pairwise data comparison during inter-run calibration.

Gene Study Window
The Gene Study window includes two tabs:

• Study Setup tab. Click this tab to manage the experiments in the Gene Study. Adding or 
removing data files in a Gene Study does not change the original data in that file

• Study Analysis tab. Click this tab to view the gene expression data for the combined 
experiments
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Figure 75 shows the Gene Study window, including the Study Setup and Study Analysis tabs.

Figure 75. Gene Study window.

Study Setup Tab
Before importing data into a Gene Study, do the following in the Data Analysis window:

• Check that samples that contain the same content are named with the same name. 
In a Gene Study, the software assumes that wells with the same Target or Sample 
name contain the same sample

• Adjust the baseline and threshold (C(t)) in the Quantitation tab to optimize the data in 
each experiment before you add them to a Gene Study

• Select the well group you want to include in the Gene Study

The Study Setup tab (Figure 75) shows a list of all the experiments in the Gene Study.

• Add experiments. Click Add Data Files to select a file from a browser window. To 
quickly add experiments to a Gene Study, drag the data files (.pcrd extension) to the 
Gene Study window

TIP: In order to show data from one well group in the Gene Study, that group must 
be selected before importing the Data file.

• Remove experiments from this Gene Study. Select one or more files in the list and 
click Remove

• Add notes about the Gene Study. Type in the Notes box to add comments about the 
files and analysis in this Gene Study
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The Study Setup tab lists the data files in the Gene Study, as described in Table 39. 

Study Analysis Tab
The Study Analysis tab shows the data from all experiments that are added to the Gene Study. 
Open this tab to analyze the data, and select these options for the Gene Expression chart:

• Mode. Select Normalized Expression (ΔΔC(t)) or Relative Quantity (ΔC(t))

• Graph Data. Select Relative to normal or Relative to control in the graph

• X-axis options. Select the labels on the x-axis of the graph, including Sample or Target

• Y-axis options. Change the labels on the y-axis of the graph, including Linear, Log 2, or 
Log 10

• Scaling Options. Choose Highest or Lowest value, or leave the data Unscaled. This 
option is only available when your samples do not contain controls

• Graph Error. Select the multiplier for standard deviation bars in the graph, including ±1, 
2, or 3

• Experiment Settings button. Choose the show options for targets and samples in the 
Experiment Settings window

• Show Details check box. Click Show Details to add more columns of data to the chart

Table 39. Study Setup tab in Gene Study window 

Column Title Description

File Name Name of the experiment data file (.pcrd extension)

File Folder Directory that stores the data file for each experiment in the 
Gene Study

Date Created Date the run data were collected

Well Group Name Name of the well group that was selected when the file was 
added to the Gene Study

TIP: In order to analyze one well group in the Gene Study, 
that well group must be selected in the Data Analysis 
window before importing the data file into the Gene Study

Step Protocol step that included the plate read to collect real-
time PCR data

Grid View Open a plate map of the plate with the data in each of the 
experiments included in the Gene Study
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Highlighting a sample in the Gene Expression chart highlights the corresponding cell in the 
spreadsheet below the chart (Figure 76). 

Figure 76. Study Analysis tab in Gene Study window.

Gene Study Data Spreadsheet
The data spreadsheet in the Gene Study window lists information about each target and 
sample in the Gene Study (Figure 76). 

Table 40 describes the information shown in the Gene Study spreadsheet.

Table 40. Information in the spreadsheet on the Study Analysis tab 

Information Description

Target Target Name (amplified gene) selected in the Experiment 
Settings window

Sample Sample Name selected in the Experiment Settings window

Ctrl Control sample, when the sample name is selected as a 
control in the Experiment Settings window

Expression Normalized Gene Expression (ΔΔC(t)) or Relative Quantity 
(ΔC(t)) depending on the selected mode

Expression SEM (or SD) Standard Error of the Mean or Standard Deviation, depending 
on the selected option

Corrected Expression SEM 
(or SD)

Corrected value calculation for Standard Error of the Mean 
(SEM) or Standard Deviation (SD) of the relative expression, 
depending on the selected option

Mean (C(t)) Mean of the threshold cycle

C(t) SEM (or SD) Standard Error of the Mean or Standard Deviation of the 
threshold cycle, depending on the selected option
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Show Details Data
Click the Show Details check box to show additional information (Figure 77).

Figure 77. Show Details data in the Gene Study tab.

The spreadsheet adds the information in the columns listed in Table 41. 

Gene Study Report Window
Open the Gene Study Report window to arrange the Gene Study data into a report. To create a 
gene study report, follow these steps:

1. Adjust the Gene Study report data and charts, as needed, before creating a report.

2. Select Tools > Reports to open the Gene Study report window.

3. Click the check boxes in the report options list to select and remove options to choose 
the data to display. Select the options shown in Table 42.

Table 41. Information added to the spreadsheet when Show Details selected

Information Description

Data Set Fluorescence data from one fluorophore in one data file

Relative Quantity Calculated relative quantity of samples

Relative Quantity SD Standard deviation of the relative quantity calculation

Corrected Relative Quantity SD Calculated standard deviation of the corrected relative 
quantity

Unscaled Expression Calculated unscaled expression

Unscaled Expression SD Calculated standard deviation unscaled expression

Corrected Unscaled Expression SD Corrected standard deviation of the unscaled 
expression

Expression Relative expression 

Wells Well number in the plate

Table 42. Categories for a Gene Study report 

Category Option Description

Header Title, subtitle, and logo for the report

Report Information Date, user name, data file name, data file 
path, and the selected well group

Gene Study File List List of all the data files in the Gene Study

Notes Notes about the data report

Analysis Parameters A list of the selected analysis parameters 

Chart Gene Expression chart showing the data

Target Names List of targets in the Gene Study

Sample Names List of samples the Gene Study

Data Spreadsheet that shows the data
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4. Fill in the text for the report by entering text and images in option panes (Figure 78).

Figure 78. Example of Header and Logo options in a Gene Study report.

5. Click Update Report to update the report preview pane. The report preview pane shows 
a view of the Report.

6. Print or save the report. Click Print in the toolbar to print the current report. Select File > 
Save to save the report as a PDF (Adobe Acrobat Reader file), MHT (Microsoft 
document), or MHTML (Microsoft document) formatted file and select a location to store 
the file. Select File > Save As to save the report with a new name or in a new location.

7. Create a report template once you create a report with the content you want to include in 
all reports. To create a template, select Template > Save or Save As and save the 
current report as a template.

Frequently Asked Questions
The following list is a series of questions (Q) and answers (A) about gene expression analysis 
in CFX Manager software.

Q: Why should I normalize my data?

A: Relative quantity data that is not normalized by some means is difficult to interpret. Imagine 
the case where you load 1 μg of RNA in one well and 10 ng in the other well. If you perform a 
relative quantity analysis on the results from such an assay, then the fact that the 10 ng sample 
has a smaller relative quantity value is irrelevant. It is likely the result of using less RNA and not 
the result of some biological response.

Q: Why does the formula for relative quantity vary from that outlined in the geNorm web site 
when a control is selected? 

Inter-Run Calibration Inter-run calibration data

Table 42. Categories for a Gene Study report  (continued)

Category Option Description
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A: This is where the CFX Manager software calculations differ from those outlined on the 
geNorm web site. In the example on that web site, the results are not scaled to the control until 
normalized expression is calculated. This is referred to as “re-scaled normalized expression” in 
the spreadsheet.

Q: How does normalized expression as calculated by CFX Manager software compare to the 
model introduced by M. Pfaffl (2001)?

A: If you only evaluate one reference gene and one gene of interest, you will get exactly the 
same results using the CFX Manager software as you would using the model introduced in M. 
Pfaffl (2001). However, standard deviations might be slightly different.

Q: How does normalized expression calculated by this software compare to the model 
outlined by Dr. Jo Vandesompele on the geNorm web site?

A: The CFX Manager software uses the models outlined on the geNorm web site and gives you 
the same results.

Q: Why would I have to assign Target Names (genes) in the Gene Expression tab?

A: If you have not assigned Target Names in your initial plate setup or if you are studying more 
than five genes, click View/Edit Plate to open the Plate Editor and assign target names to the 
wells in the plate.

Q: Can I customize my target (gene) and sample (condition) names?

A: Yes. Open the Experiment Settings window (page 44) to add names to the Targets or 
Samples tabs, where you can also enter or remove the full names from the lists. Alternatively, 
permanently add long lists of names to the Libraries for target and sample names in the Plate 
tab in the User Preferences window (page 105). These names appear on the axis in various 
chart views, including gene expression.

Q: How do I determine reaction efficiencies?

A: Typically the efficiency for each primer (or primer/probe) set is evaluated and recorded 
during assay development. Generate a standard curve using serial dilutions of a representative 
sample across a relevant dynamic range, and then record the efficiency for subsequent gene 
expression analysis.

Gene Expression Calculations
CFX Manager software calculates formulas automatically and displays the resulting 
information in the Data Analysis tabs.

Reaction Efficiency
Evidence suggests that using accurate measure of efficiencies for each primer and probe sets 
gives you more accurate results when analyzing gene expression data. The default value of 
efficiency used in the gene expression calculations is 100%. To evaluate the reaction 
efficiency, generate a standard curve using serial dilutions of a representative sample across a 
relevant dynamic range, and then record the efficiency for subsequent gene expression 
analysis. If your experiment includes a standard curve, the software automatically calculates 
the efficiency and displays it under the Standard Curve on the Quantitation tab when Auto 
Efficiency is checked in the Targets tab in the Experiment Settings window. 
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The efficiency formulas refer to the “efficiencies” as described by Pfaffl (2001) and 
Vandesompele et al. (2002). In these publications, an efficiency of 2 (perfect doubling with 
every cycle) is equivalent to 100% efficiency in CFX Manager software. You have the option to 
convert your efficiency calculations to those used in the software by using the following 
mathematical relationships:

• E = (% Efficiency * 0.01) + 1

• % Efficiency = (E - 1) * 100

Relative Quantity
The relative quantity (ΔC(t)) for any sample (GOI) is calculated with this formula:

Where:

• E = Efficiency of primer and probe set. This efficiency is calculated with the formula 
(% Efficiency * 0.01) + 1, where 100% efficiency = 2

• CT (MIN) = Average C(t) for the Sample with the lowest average C(t) for GOI

• CT (sample) = Average C(t) for the Sample

• GOI = Gene of interest (one target)

Relative Quantity When a Control Is Selected
When a control sample (control) is assigned, then the relative quantity (RQ) for any sample with 
a gene of interest (GOI) is calculated with this formula:

Where: 

• E = Efficiency of primer and probe set. This efficiency is calculated with the formula 
(% Efficiency * 0.01) + 1, where 100% efficiency = 2

• CT (control) = Average C(t) for the control sample

• CT (sample) = Average C(t) for any samples with a GOI

• GOI = Gene of interest (one target)

Standard Deviation of the Relative Quantity
The standard deviation of the relative quantity is calculated with the following formula:

Where:

• SD Relative Quantity = standard deviation of the relative quantity

• SD C(t) GOI = Standard deviation of the C(t) for the sample (GOI)

• Relative Quantity Sample X = Relative quantity of the sample

• E = Efficiency of primer and probe set. This efficiency is calculated with the formula 
(% Efficiency * 0.01) + 1, where 100% efficiency = 2

• GOI = Gene of interest (one target)

Relative Quantitysample (GOI) EGOI
(CT (MIN) C– T (sample) )=

Relative Quantitysample (GOI) E
GOI

CT (control) C– T (sample)( )=

SD Relative Quantity SD C(t) GOI Relative QuantitySample X Ln (EGOI×× )=
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Normalization Factor
The denominator of the normalized expression equation is referred to as the normalization 
factor. The normalization factor is the geometric mean of the relative quantities of all the 
reference targets (genes) for a given sample, as described in this formula:

Where:

• RQ = Relative quantity

• n = Number of reference targets

• GOI = Gene of interest (one target)

Normalized Expression
Normalized expression (ΔΔC(t)) is the relative quantity of your target (gene) normalized to the 
quantities of the reference targets (genes or sequences) in your biological system. To select 
reference targets, open the Experiment Settings window and click the reference column for 
each target that serves as a reference gene.

The calculation for normalized expression is described in the following formula, which uses the 
calculated Relative Quantity (RQ) calculation:

Where:

• RQ = Relative quantity of a sample

• Ref = Reference target in an experiment that includes one or more reference targets 
in each sample

• GOI = Gene of interest (one target)

Provided that reference targets do not change their expression level in your biological system, 
the calculation of normalized expression will account for loading differences or variations in 
cell number that is represented in each of your samples. 

Normalized Expression When a Control Is Selected
When you select a control sample in the Experiment Settings window, the software sets the 
expression level of the control sample to 1. In this situation, the software normalizes the 
relative quantities of all target (gene) expression to the control quantity (a value of 1). This 
normalized expression is equivalent to the unscaled normalized expression analysis when a 
control is chosen.

Normalization Factorsample (GOI) (RQsample (Ref 1) RQsample (Ref 2) … RQsample (Ref n))×××
1
n
---

=

Normalized Expressionsample (GOI)
RQsample (GOI)

RQsample (Ref 1) RQsample (Ref 2) … RQsample (Ref n)×××( )
1
n
---

---------------------------------------------------------------------------------------------------------------------------------------------=
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Standard Deviation for the Normalized Expression
Rescaling the normalized expression value is accomplished by dividing the standard deviation 
of the normalized expression by the normalized expression value for the highest or lowest 
individual expression level, depending on the scaling option you choose. The standard 
deviation (SD) of the normalization factor is calculated with this formula:

Where:

• RQ = Relative quantity of a sample

• SD = Standard deviation

• NF = Normalization factor

• Ref = Reference target

• n = Number of reference targets 

When a control sample is assigned, you do not need to perform this rescaling function on the 
standard deviation, as shown in the following formula:

Where: 

• NE = Normalized Expression

• RQ = Relative quantity of a sample

• SD = Standard deviation

• GOI = Gene of interest (one target)

Normalized Expression Scaled to Highest Expression 
Level
When the experiment does not include controls, scale the normalized expression (NE) for each 
target (gene) by dividing the expression level of each sample by the highest level of expression 
in all the samples. The software sets the highest level of expression to a value of 1, and re-
scales all the sample expression levels. The highest scaling is calculated by this formula:

Where:

• GOI = Gene of interest (target)

SD NFn NFn
SD RQsample (Ref 1)
n RQsample (Ref 1)×
---------------------------------------------⎝ ⎠
⎛ ⎞

2 SD RQsample (Ref 2)
n RQsample (Ref 2)×
---------------------------------------------⎝ ⎠
⎛ ⎞

2
…

SD RQsample (Ref n)
n RQsample (Ref n)×
---------------------------------------------⎝ ⎠
⎛ ⎞

2
+ + +×=

SD NEsample (GOI) NEsample (GOI)
SD NFsample

NFsample
------------------------------⎝ ⎠
⎛ ⎞

2 SD RQsample (GOI)
RQsample (GOI)

-------------------------------------------⎝ ⎠
⎛ ⎞

2
+×=

Scaled Normalized Expressionsample (GOI)
Normalized Expressionsample (GOI)

Normalized ExpressionHighest sample (GOI)
--------------------------------------------------------------------------------------------------=
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Normalized Expression Scaled to Lowest Expression 
Level
When the experiment does not include controls, scale the normalized expression (NE) for each 
target (gene) by dividing the expression level of each sample by the lowest level of expression 
in all the samples. The software sets the lowest level of expression to a value of 1, and re-
scales all the sample expression levels. The lowest scaling is calculated by this formula:

Where:

• GOI = Gene of interest (target)

Standard Deviation for the Scaled Normalized Expression
Rescaling the scaled normalized expression (NE) value is accomplished by dividing the 
standard deviation (SD) of the normalized expression by the normalized expression value for 
the highest (MAX) or lowest (MIN) expression level, depending on the scaling option.

NOTE: When a control sample is assigned, you do not need to perform this 
rescaling function on the standard deviation.

The formula for this calculation is shown here:

Where:

• NE = Normalized expression

• SD = Standard deviation

• GOI = Gene of interest (target)

• MAX = Highest expression level

• MIN = Lowest expression level

Corrected Values Formulas
A difference between corrected values and noncorrected values is only seen if a standard 
curve is created as part of the real-time PCR experiment. The software uses three equations in 
determining the error propagation:

• Standard error

• Standard error for normalized expression

• Standard error for the normalized gene of interest (target)

The formula for standard error is shown here:

Where 

• n = Number of reference targets (genes)

• SD = Standard deviation

Scaled Normalized Expressionsample (GOI)
Normalized Expressionsample (GOI)

Normalized ExpressionLowest sample (GOI)
-------------------------------------------------------------------------------------------------=

SD Scaled NEsample (GOI)
SD NEsample (GOI)

NEMAX or MIN (GOI)
-----------------------------------------------=

Standard Error SD
n

-------=
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The standard error for the normalization factor in the normalized expression formula is shown 
here:

Where:

• n = Number of reference targets

• SE = Standard error

• NF = Normalized expression

• RQ = Relative quantity

The standard error for normalized gene of interest (GOI) formula is shown here:

Where:

• SE = Standard error

• GOI = Gene of interest (one target)

• NF = Normalization factor

• n = Number of reference targets

SE NFn NFn
SE RQsample (Ref 1)

n SE RQsample (Ref 1)×
------------------------------------------------------⎝ ⎠
⎛ ⎞

2 SE RQsample (Ref 2)
n SE RQsample (Ref 2)×
------------------------------------------------------⎝ ⎠
⎛ ⎞

2
…

SE RQsample (Ref n)
n SE RQsample (Ref n)×
------------------------------------------------------⎝ ⎠
⎛ ⎞

2
+ + +×=

SE GOIn GOIn
SE NFn

NFn
------------------⎝ ⎠
⎛ ⎞

2 SE GOI
GOI

-------------------⎝ ⎠
⎛ ⎞+

2
×=
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9 Users and Preferences
Read this chapter to learn more about managing software users and their preferences:

• Logging in and Selecting a User (below)

• User Preferences window (page 102)

• Configuring email notification (page 103)

• User Administration (page 109)

Logging in and Selecting a User
CFX Manager software manages multiple users and their preferences. The current, logged in 
software user is displayed at the top of the main software window (Figure 79).

Figure 79. User name displayed. 

CFX Manager software manages who logs in to the software through the Login dialog box 
(Figure 80). When you start the software, the Login dialog box opens automatically if there are 
two or more users listed in the User Administration window.

Figure 80. Login dialog box.

Log in to the software, or switch users by following these steps:

1. Open the Login dialog box, if it is not already open, by clicking the Select User button in 
the toolbar or selecting User > Select User in the menu bar.

2. Select a name from the User Name pull-down list. The default is “Admin” (administrator).

3. Type a password in the Password box.

4. Click OK to close the Login dialog box and open the software. 
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5. To add a new user name and password, contact your software administrator.

Changing a Password
Change a password by following these steps:

1. Select User > Change Password from the main software window menu to open the 
Change Password dialog box (Figure 81).

2. Enter the old password in the Old Password box.

3. Enter the new password in the New Password and the Confirm New Password boxes.

4. Click OK to confirm the change. 

Figure 81. The Change Password window.

User Preferences Window
CFX Manager software tracks the preferences of each user that logs in to the software. To 
change user preferences, open the User Preferences window using one of these methods:

• Click User Preferences in the main software window toolbar

• Select User > User Preferences in the main software window menu bar

• Click one of the tabs (Figure 82) to view or change preferences

Figure 82. User Preferences window with tabs.
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Email Tab
Select the Email tab (Figure 82) to enter the email addresses where you want to receive 
confirmation of the completion of the run. The software can send an attached data file or 
report file with the email when the check boxes next to these options are checked. 

Configuring Email Notification
Click Configure Outgoing Email to open the Options window (Figure 83), configure the SMTP 
server, and send a test email from the computer. Input the following:

• SMTP Server Name. The name of the SMTP server as provided by your ISP

• Port. The port number of your SMTP server, as provided by your ISP; this is usually 25

• Use SSL. Whether to use Secure Sockets Layer. Some SMTP servers require this to be 
used, others require that it not be used

• Use Default “From” Address. This can usually be left in the default checked state. 
However, some SMTP servers require all sent email to have a “from” address that is from 
a certain domain, i.e.<name>@YourCompany.com. If that is the case, this checkbox 
must be unchecked, and a valid “from” email address must be supplied in the box 
labeled “From” Address:

• Authentication Required. Many SMTP servers require authentication. If so, this 
checkbox must be checked, and a User Name and Password must be supplied

• Test email. To test the email settings, enter one or more email addresses in Test Email 
Address text box. Multiple email addresses can be separated by a comma. Then click 
the Test Email button

Figure 83. Options to configure email.

NOTE: Some SMTP servers do not allow attachments, and others allow 
attachments only up to certain sizes. If you are going to use CFX Manager software 
to email Data Files and/or Reports, you may want to test your server's ability to 
email attachments by checking the Test Attachment box, and setting the 
Attachment Size to 5 megabytes (MB) or more.
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Files Tab
Select the Files tab to list the default locations for opening and saving files (Figure 84). 

• Default Folder for File Creation. Select a default folder where you want to save new 
files. Select a location for each file type (Protocol, Plate, Data, or Gene Study file)

• File Selection for Experiment Setup. Select the default protocol and plate files that 
appear when you open the Experiment Setup window

• Data File Prefix. Define the beginning text of the file name for data files. The default 
setting instructs the software to create a file name that starts with the User (user name of 
the user who is currently logged on to the software), Date (file creation date), and 
Instrument Name (instrument serial number or name)

Figure 84. Files tab in the User Preferences window.

TIP: Click the “...” button to the right of each box to open a browser window and 
locate a folder.

Protocol Tab
Select the Protocol tab in the User Preferences window (Figure 85) to specify the default 
settings for a new protocol file in the Protocol Editor window:

• Protocol Editor. Set the default settings that appear in the Protocol Editor. Select a 
default Sample Volume to describe the volume of each sample in the wells (in μl), and 
select a Lid Shutoff Temperature at which the lid heater turns off during a run
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• Protocol AutoWriter. Selects default settings that appear in the Protocol AutoWriter, 
including default annealing temperature for experiments that use iProof, iTaq, or Other 
polymerases and the default amplicon length

Figure 85. Protocol tab in the User Preferences window.

Plate Tab
Select the Plate tab in the User Preferences window (Figure 86) to specify the following default 
settings for a new Plate file in the Plate Editor window:

• Plate Type. Select the default plate well type from the list

NOTE: The plate size default that is shown when the Plate tab is first opened is 
linked to the instrument pull down-menu in the Startup Wizard. Make sure you 
select MiniOpticon from the list.

• Plate Size. Select the default plate size from the list

• Units. Select the units used to describe the concentration of the starting template for 
wells that contain standards. The software uses these units to create a standard curve in 
the Data Analysis Quantitation tab

• Scientific Notation. Select scientific notation to view concentration units in that notation

• Scan Mode. Select a default scan mode to set the number of channels to scan during a 
run 

• Fluorophores. Click check boxes to select the default fluorophores that appear in the 
Plate Editor well loading controls

• Libraries. Enter the target and sample names that you typically use in your experiments. 
Enter target names to list genes and sequences, and enter sample names to list 
conditions for experiment samples. These names appear in the lists of in the Targets tab 
and Samples tab in the Experiment Settings window 
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Figure 86. Plate tab in the User Preferences window.

Data Analysis Tab
Select Data Analysis in the User Preferences window (Figure 87) to change the default 
settings for data that are displayed in the Data Analysis window.

Figure 87. Data Analysis tab in the User Preferences window.

For the quantification data, select the following settings:

• Analysis Mode. Select the default base lining method for the analysis mode. Choose 
Baseline Subtracted Curve Fit, No Baseline Subtraction, or Baseline Subtracted
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• C(t) Determination Mode. Select between Regression mode or Single Threshold 
mode to determine how C(t) values are calculated for each fluorescence trace

• Log View. Select On to show a semi-logarithmic graph of the amplification data. Select 
Off to show a linear graph

For the allelic discrimination data, select the following settings:

• Display Mode. Select RFU to show the data as a graph of the RFU, or select Threshold 
Cycle to show a graph of threshold cycles

• Normalize Data. This selection is only available when RFU is selected. Select No to 
show unnormalized data. Select Yes to normalize the data to the control sample

For the end point data, select the following settings. Select the number of end cycles to 
average when calculating the end point calculations:

• PCR. Enter a number of cycles for PCR to average the end cycles for quantitation data 
(default is 5)

• End Point Only Run. Enter a number of cycles for End Point Only Run to average the 
end cycles for end point data (default is 2) 

Gene Expression Tab
Select Gene Expression in the User Preferences window (Figure 88) to specify the default 
settings for a new Gene Expression data file.

Figure 88. Gene Expression tab in the User Preferences window.

Specify the default settings for a new Gene Expression data file:

• Relative to. Select Zero or Control. To graph the gene expression data originating at 1 
(relative to a control), select Control. When you assign a control sample in the 
Experiment Setup window, the software automatically defaults to calculate the data 
relative to that control. Select Zero to instruct the software to ignore the control, which is 
the default selection when no control sample is assigned in the Experiment Settings 
window

• X-Axis. Graph the Sample or Target on the x-axis
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• Y-Axis. Graph Linear, Log 2, or Log 10 scale on the y-axis

• Scaling. Select a scaling option for the graph. Leave the graph Unscaled. Alternatively, 
choose a scaling option to scale to the Highest value or to the Lowest value

• Method. Set the default analysis mode, including relative expression (ΔCt) or normalized 
expression (ΔΔCt) or relative expression (ΔCt)

• Error Bar. Select Std Dev. for standard deviation, or Std. Error Mean for the standard 
error of the mean

• Std Devs. Select the standard deviation multiplier to graph the error bars. The default is 
1. Change the multiplier to either 2 or 3

QC Tab
Select the QC tab in the User Preferences window to specify QC rules to apply to data in Data 
Analysis Module. The software validates the data against the enabled tests and the assigned 
values (Figure 89). 

NOTE: Wells that fail a QC parameter can easily be excluded from analysis in the 
QC module of the Data Analysis Window using the right-click menu option. 

Figure 89. QC tab in User Preferences.

Specify to add cut off values and to enable the following QC rules:

• Negative control with a C(t) less than XX. Input a C(t) cut-off value

• NTC (no template control) with a C(t) less than XX. Input a C(t) cut-off value

• NRT (no reverse transcriptase control) with a C(t) less than XX. Input a C(t) cut-off 
value

• Positive control with a C(t) greater than XX. Input a C(t) cut-off value

• Unknown without a C(t)

• Standard without a C(t)

• Efficiency greater than XX. Input a reaction efficiency cut-off value that is calculated 
for the standard curve

• Efficiency less than XX. Input a reaction efficiency cut-off value that is calculated for 
the standard curve
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• Std Curve R^2 less than XX. Input a cut-off R^2 value for the standard curve

• Replicate group C(t) Std Dev greater than XX. Input a cut-off standard deviation that 
is calculated for each replicate group

User Administration
Open the User Administration window in the main software window:

• Select Users > User Administration

• Click User Administration in the menu bar

If you log in as an Administrator, open the User Administration window to manage users and 
user rights:

• Manage Users. Add or remove users, and assign each user a role

• Manage Rights. Change rights for user roles (Principal, Operator, or Guest)

NOTE: Only users who are Administrators can edit this window. Other users can 
only view it.

To assign a role to each user, select from the list of roles in the User Administration window 
(Figure 90). In this example, the Guest user is given the added right to save files. 

Figure 90. User Administration window with three users.

Adding and Removing Software Users
Only a software Administrator can add and remove users. To add software users in the 
Manage Users pane, follow these steps:

1. Enter a user name for the new software user. 

2. Select a user role. These roles restrict the rights of each user. The default is Principal.

3. (Optional) Enter a full name and password for the new software user.

4. Click OK to open a dialog box and confirm that you want to close the window. 

5. Click Yes to close the dialog box and window.
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To remove a software user, follow these steps:

1. In the Manage Users pane, click the box in the Delete list for each software user you 
want to remove.

2. Click OK to open a dialog box and confirm that you want to close the window.

3. Click Yes to close the dialog box and window.

NOTE: The list of software users must always include one Administrator.

Assigning Rights for User Roles
The User Administration window provides access to user roles and rights. The software 
includes these four roles:

• Administrator (required). Each Administrator has all rights, and you cannot change 
those rights. The Administrator can also add and remove software users, and change the 
rights for each role

• Principal. By default each Principal has all rights

• Operator. By default each Operator has all rights except skipping cycles and creating a 
Gene Study

• Guest. By default each Guest has no additional rights, and can only read files

To specify the rights for each role, follow these steps. Only a software Administrator can 
change the rights for any role: 

1. In the Manage Rights pane, click a box under the name of the role to add or remove that 
right. Click one or more rights in the list. To change all the rights for all the roles to the 
default list, click Restore Default Rights.

2. Click OK to open a dialog box and confirm that you want to close the window.

3. Click Yes to close the dialog box and window.

To view your current user role and rights, select User > User Administration. Contact a 
software administrator to modify the user settings, rights, and roles listed in the User 
Administration window. A Principal, Operator, or Guest user can only view their user settings, 
rights, and roles.
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10 Resources
Read this chapter to learn more about resources for the MiniOpticon system:

• Calibration Wizard (below) 

• Instrument maintenance (page 112)

• Application Log (page 114)

• Troubleshooting (page 114)

• References (page 115)

Calibration Wizard
The MiniOpticon system is factory calibrated for commonly used fluorophores in Bio-Rad 
white-welled plates (Table 43).

To open the Calibration Wizard to calibrate the MiniOpticon system:

1. Select an instrument in the Detected Instruments pane.

2. Select Tool > Calibration Wizard to open the Dye Calibration window and calibrate new 
dye and plate combinations (Figure 91).

Table 43. Factory calibrated fluorophores, channels, and instruments 

Fluorophores Channel

FAM, SYBR® Green I 1

HEX 2
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Figure 91 shows an example of the Dye Calibration window.

Figure 91. Dye Calibration window.

Calibrating the MiniOpticon System
To calibrate the MiniOpticon system in the Dye Calibration window:

1. Select the Plate Type in the Calibrate New or Existing Fluorophores pane. If the plate 
type is not included in the list, type the name in the box to add it to the list.

2. Select the fluorophore you want to calibrate from the pull-down list. If the fluorophore 
name is not included in the list, type the name in the box to add it to the list.

3. Begin preparing a 48-well plate for dye calibration by pipetting dye solution into each 
well. For each fluorophore, fill each well with 50 μl of 300 nM dye solution.

4. Seal the plate using the sealing method you will use in your experiment.

5. Click Next and follow the on-screen instructions. First, place an empty plate in the 
MiniOpticon system for the first procedure of the calibration. Next, place the calibration 
plate in the block and close the lid for the second procedure of the calibration. Click OK 
to confirm that the plate is in the block.

6. When the CFX Manager software completes the calibration run, a dialog box appears. 
Click Yes to finish calibration and open the Dye Calibration Viewer.

7. Click OK to close the window. 

Instrument Maintenance
The MiniOpticon system includes a sensitive optical detector system and a sample block that 
must heat and cool very fast. Contamination of these components can interfere with thermal 
cycling and data collection. 

WARNING! Never allow a reaction to run with an open or leaking sample lid. The 
reagents could escape and coat the block, inner lid, or optical detection system. 
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Excessive dirt can dim the signal, and fluorescence contamination can create 
excessive background signal.

Avoid contaminating the MiniOpticon system by following these suggestions:

• Always clean the outside of any containers before placing them in the block

• Never run a reaction with a seal that is open, loose, punctured, or otherwise 
damaged because you could contaminate the block, inner lid, and optical system

• Never run a PCR or real-time PCR reaction with volatile reagents that could explode 
and contaminate the block, inner lid, and optical system

• Never clean or otherwise touch the optical system behind the heater plate holes that 
are in the inner lid

Cleaning the Sample Block
The thermal block of the MiniOpticon system should be cleaned on a regular schedule to 
remove any debris or dirt that might interfere with proper function. Clean as soon as you 
discover debris and spilled liquids with a soft, lint-free cloth that is dampened with water. 
Cleaning the instrument allows precise instrument function.

WARNING! Never use cleaning solutions that are corrosive to aluminum. Avoid 
scratching the surface of the thermal block. Scratches and damage to this surface 
interfere with precise thermal control.

WARNING! Never pour water or other solutions in the reaction module bay. Wet 
components can cause electrical shock when the thermal cycler is plugged in.

Clean the MiniOpticon system as soon as you discover debris, dirt, or contamination in the 
block or on the inner lid. Any dirt can interfere with the ability of the block to change 
temperature quickly and collect accurate fluorescent data. To clean the reaction module, 
follow these guidelines. Follow these suggestions for cleaning:

WARNING! To prevent electrical shock, always unplug the base before cleaning 
the instrument.

WARNING! Never touch or allow solutions to touch the optical system that is 
located behind the heated plate holes in the inner lid.

TIP: For instructions on handling and cleaning radioactive or biohazardous 
materials, consult the guidelines for radiation safety and biosafety provided by your 
institution. These guidelines include cleaning, monitoring, and disposal methods 
for hazardous materials.

• Clean the outer surface.  Use a damp cloth or tissue to clean spills off the outside 
case. If needed, use a mild soap solution, and then rinse the surface with a damp cloth. 
Cleaning the cover will prevent corrosion

NOTE: Never use cleaning solutions that are corrosive to aluminum, such as bleach 
or abrasive cleansers.

• Use of oil in the wells is not recommended. If oil is used, the wells must be cleaned 
thoroughly and often. Remove the oil when it is discolored or contains dirt. Use a 
solution of 95% ethanol to clean oil. Do not allow oil to build up in the block

• Clean the wells in the block. Clean spills immediately to prevent them from drying. Use 
disposable plastic pipets with water (recommended), 95% ethanol, or a 1:100 dilution of 
bleach in water. Also use a soft, lint-free cloth or paper towel and water to clean the 
block. Always rinse the wells with water several times to remove all traces of cleaning 
reagents

WARNING! Never clean the block with strong alkaline solutions (strong soap, 
ammonia, or high-concentration bleach). Never use corrosive or abrasive cleaning 
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solutions. These cleaning agents can damage the block and prevent precise 
thermal control.

WARNING! Bleach, ethanol, or soap that is left in the blocks could corrode the 
block and destroy plastics during a run. After cleaning, always rinse the wells 
thoroughly with water to remove all traces of cleaning reagents.

WARNING! Never heat the block after adding a cleaning solution. Heating the 
block with cleaning solution will damage the block, reaction module, and thermal 
cycler base.

• Clean the inner lid. Use a soft, lint-free cloth and water to remove debris and solutions 
from the inner lid surface. Never use abrasive detergents or rough material that will 
scratch the surface. Cleaning the inner lid improves precise sample heating and cooling

Application Log
Before starting a new run, the instrument initiates a self-diagnostic test to verify that it is 
running within specifications. The software records results of this test in the Run log and 
Application log file. If you notice a problem in one or more experiments, open the run and 
application logs to find out when the problem started happening.

CFX Manager software tracks information about the state of an instrument during a run in the 
Application Log (Figure 92). Use these logs to track events that occur on instruments and in 
the software and for troubleshooting.

To open the Application log in the main software window, select View > Application Log. 

Figure 92. Example of an Event Log file.

Troubleshooting
Typically, software and instrument communication problems can be resolved by restarting your 
computer and the system. Be sure to save any work in progress before restarting.

NOTE: Check that your computer has sufficient RAM and free hard drive space. 
The minimum RAM is 2 GB, and the minimum hard drive space is 20 GB.
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Installing the Software Manually
If needed, install the software manually by following these instructions:

1. Insert the software CD.

2. Right-click the software CD icon, and select Explore to open the CD window.

3. Double-click the CFX_Manager folder to open the folder, and then double-click 
setup.exe to start the software installation wizard. 

4. Follow the instructions on the wizard to install the software, and then click Finish.

Power Failure Options
In a power failure, the instrument and computer will shut down. If the power failure is short, the 
instrument will resume running a protocol, but the Application log will note the power failure. 
Depending on the computer settings and the length of time that the power is off, the 
instrument and software attempt to continue running the experiment when they are restarted.
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Minpack Copyright Notice (1999) University of Chicago. All rights reserved

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the 
following acknowledgment:

“This product includes software developed by the University of Chicago, as Operator of 
Argonne National Laboratory.
115



Resources
116



MiniOpticon Manual
Index

A
Add Repeats, 23
Adding

Beep, 33
Extend, 33
Increment, 33
Ramp rate, 33
Repeats in run, 23

Adjusting
Allelic Discrimination data, 73
Data analysis charts, 58
End point data, 72
Gene expression data, 82
Melt Curve Data, 67
Threshold, 54
Trace color, 62
Trace style, 62

Allelic Discrimination, 72
Adjusting data, 73
RFU, 72, 75
Spreadsheet, 74

Amplicon length, 34, 35
Analysis Mode, 55
Annealing temperature

Protocol AutoWriter, 34, 35
Auto Efficiency, 46, 86

B
Back panel, 2
Balance

Cut microplates, 8
How to, 8
Tube strips, 8

Baseline
Window, 54

Baseline Subtracted
Curve Fit mode, 55

Baseline Subtracted mode, 55
Baseline Threshold window, 54
Beep, 33
Bio-Rad Laboratories

Contact, ii
Resources, ii

Block, 2
Mode, 33

Button, 23
Clear Replicate #, 44
Clear Wells, 44
Close lid, 2, 22
Delete step, 33
Experiment Settings, 44
Flash Block Indicator, 23
Open lid, 22
Pause, 23
Protocol AutoWriter, 33
Protocol Editor, 29
Resume, 23
Show Analysis Settings, 46, 86
Skip Step, 23

C
Calculated mode, 33
Calibration

Inter-run in a Gene Study, 88
Cancelling a run, 23
CFX Manager

Files, 16
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Changing
Baseline, 54
Sample volume, 19, 29
Thresholds, 54

Chart
Data analysis, 58

Clear Replicate #, 44
Clear Wells button, 44
Clearing wells in Plate Editor, 57
Close button for lid, 2
Close Lid button, 22
Closing the lid, 22
Coefficient of Variation, 83
Collection Name, 44, 85
Color, 41, 46, 87
Concentration, 42, 43
Contact Bio-Rad Laboratories, ii
Control

Relative quantity with, 95
Creating

Data report, 77
Protocol, 35
Well groups, 46

D
-d(RFU)/dT

Spreadsheet, 70
Data

Files, 16
Data analysis

About, 49
Adjusting, 49
Charts, adjusting, 58
Clearing wells, 57
Data analysis, 72
End Point, 70
Excluding wells, 56
Formula, 94
Gene Expression, 79
Melt Curve, 66
Menu bar, 51
Plate content, 49
Toolbar, 50
Well contents, 49
Well groups, 46
Well selector, 55

Data file
Report, 76

Data report
Creating, 77

Delete Step button, 33
Deleting a step, 33

Detected Instruments, 10
Dilution Series, 44

E
Email Setup in CFX Manager, 103
Email Tab, 103
End Point

Adjusting data, 72
Changing sample volume in protocol, 19
RFU data analysis, 70
Spreadsheet, 72
Tab, 71

End Point Only Run protocol, 18
Enzyme type, 34, 35
Exclude well using right click option, 56
Excluding wells

Plate Editor, 56
Experiment Settings, 44

Auto Efficiency, 46, 86
Button, 44
Color, 46, 87
Show Analysis Settings button, 46, 86
Show Graph, 46, 87
Targets tab, 44, 85

Export All Data Sheets to Excel, 51
Export Template, 47
Express Load

Protocol, 18, 19
Extend, 33

F
Files

Data, 16
Gene Study, 16
Plate, 16
Protocol, 16
Software, 16

Flash Block Indicator button, 23
Fluorophores, 42
Formula, 95

Data analysis, 94
E (see reaction efficiency), 63
Normalized expression, 96, 98
Normalized expression, scaled, 97
Reaction Efficiency (E), 63
Relative quantity, 95
SD normalized expression, 98
Standard error, 98
Standard error normalized expression, 98

Front view, 2
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G
Gene expression

Adjusting data, 82
Data analysis, 79
Graph data, 82
Normalizing data, 81
Relative quantity, 82
Right-click for graph, 83
Scaling options, 82
Spreadsheet, 84
Tab, 80

Gene Study, 87
Files, 16
Inter-run calibration, 88
Preparing data, 89
Report, 92
Show Details, 92
Study Analysis tab, 88, 90
Study Setup tab, 89

Glossary
Software, 16

GOI
Normalization factor, 96
Normalized expression, 96, 97, 98
Relative quantity, 95
SD Normalized expression, 98

GOTO
Adding repeats, 23
Inserting, 31

Gradient
Inserting, 30
Step, 30

Gradient Calculator, 28

H
Heated plate, 2

I
Import Template, 47
Increment, 33
Inner lid, 2
Instruments

Safety, iii
Warning labels, iii

Inter-run calibration, 88

L
Layout

Quantitation tab, 52, 62
LED on lid, 2
Library, 42
Lid

Green LED, 2
Opening, 22

M
Magnification in Plate Editor, 40
Main software window, 9
Melt Curve

Adjusting data, 67
Data analysis, 66
Inserting, 31
Opening tab, 66
RFU data, 66
Spreadsheet, 67

Melt Curve Data, 69
Amplification Data (RFU), 69
Plate, 69
Tab, 68

Melt Peaks
Spreadsheet, 68

Menu bar
Data analysis, 51
Main software, 9, 10
Plate Editor, 38
Protocol Editor, 28

Mode
Analysis, 55
Baseline Subtracted, 55
Baseline Subtracted Curve Fit, 55
Not Baseline Subtracted, 55
Temperature control, 33

Multiple instruments
Viewing, 15

M-value, 83

N
Normalization factor

Relative quantity, 96
Normalized expression

Formula, 96
Formula for GOI, 98
Scaled to highest, 97
Scaled to lowest, 98
Standard deviation (SD), 98
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Standard deviation formula, 97
Normalized GOI formula, 98
Normalizing

Gene expression, 81
Not Baseline Subtracted mode, 55
Notes

Well, 42

O
Open Lid button, 22
Opening

Lid, 22
Melt Curve tab, 66
Protocol AutoWriter, 33
Protocol Editor, 27

Operation requirements, 3

P
Pause

Button, 23
Run, 23

Plastic Consumables, 8
Plate

Contents of wells, 42
Files, 16
Melt Curve Data, 69
Size, in Plate Editor, 39
Spreadsheet, 47, 69
Spreadsheet in Plate Editor, 38
Type, 39
Well contents, 42

Plate Editor
Clear Replicate #, 44
Clear Wells button, 44
Clearing wells, 57
Concentration, 43
Dilution Series, 44
Excluding wells, 56
Experiment Settings, 44
Export plate spreadsheet, 47
Import plate spreadsheet, 47
Layout, 38
Magnification, 40
Menu bar, 38
Plate size, 39
Plate Type, 39
Replicate #, 43
Replicate Group, 43
Replicate series, 43
Sample Name, 43

Sample Type, 42
Scientific notation, 39
Selecting fluorophores, 41
Spreadsheet, 39, 47
Target Name, 42
Toolbar, 38, 39
Units, 39
Well Groups Manager, 40
Well Notes, 44

Plate Editor window, 38
Plate Loading Guide, 38
Power

Input, 2
Switch, 2

Protocol
Block mode, 33
Calculated mode, 33
End point, 18
Express load, 18, 19
Files, 16
Steps, temperature, 27

Protocol AutoWriter, 35
Amplicon length, 34, 35
Annealing temperature, 34, 35
Button, 33
Creating a protocol, 35
Examples of protocol, 34
Run time, 34

Protocol Editor
Buttons, 28, 29
Delete step, 33
Inserting GOTO, 31
Inserting gradient, 30
Inserting melt curve, 31
Menu bar, 28
Toolbar, 28
Window, 27

Q
QC Tab, 74
Quantitation

Description, 52
Tab, 52
Tab layout, 52, 62

R
Ramp rate, 33
Reaction efficiency (E)

Formula, 63
Targets, 63
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Real-Time Status, 23
Regression Mode, 53
Relative quantity

Control sample selected, 95
Described, 82
Formula, 95
GOI, 95
Normalization factor, 96
Normalized expression, 97
Standard deviation formula, 95

Replace Plate File, 24
Replicate #, 43
Replicate Group, 43
Replicate Series, 43
Report

Data file, 76
Gene Study, 92

Requirements
Operation, 3

Resume button, 23
Resuming a run, 23
RFU

Allelic Discrimination, 72, 75
End Point tab, 70, 71
Melt Curve tab, 66

Right-click
Gene expression graph, 83
Selected Block(s) list, 21

Run
Adding repeats, 23
Cancelling, 23
Flash block, 23
Pausing, 23
Skipping a step, 23
Stopping, 23

Run Details
Real-Time Status tab, 23
Run Status, 22
Time Status tab, 24
Window, 21

Run Information
Tab, 75

Run Status
Tab, 22

Run time, 34

S
Safe use specifications, iv
Safety

Instruments, iii
Warning labels, iii
Warnings, ii, iii

Sample
Name, 42, 43
Type, 42

Sample Name Grouping, 46, 85
Sample Volume

Changing in end point, 19
Sample volume

Changing, 29
Scaling option in gene expression, 82
Scientific notation, 39
Select Fluorophores

Color, 41
Selected check box, 41

Selecting
Analysis mode, 55
Fluorophores in plate, 41

Show Analysis Settings, 46, 86
Show Details

Gene Study, 92
Show Graph, 46, 87
Single Threshold Mode, 53
Skip Step button, 23
Skipping a step, 23
Software

Glossary, 16
Main window, 9
Tips and tricks, 16

Specifications
Safe use, iv

Spreadsheet
Allelic Discrimination, 74
Amplification Data for Melt Curve, 69
-d(RFU)/dT for Melt Curve, 70
End Point, 72
Gene expression, 84
Melt Curve, 67
Melt Peaks, 68
Plate Editor, 38, 39
Plate in Melt Curve Data, 69
RFU for Melt Curve, 69

Standard Curve
Well groups, 46

Standard deviation
Formula for normalized expression, 98
Normalized expression, 97, 98
Relative quantity, 95

Standard error, 98
Formula, 98
Normalized expression formula, 98

Startup Wizard, 9, 13
Step

Temperature, 29
Stop button, 23
Stopping a run, 23
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Study Analysis tab, 88, 90
Study Setup tab, 88, 89
Support

Bio-Rad representatives, ii
Technical, ii
Technical Notes, ii

T
Tab

End Point, 71
Gene Expression, 80
Melt Curve Data, 68
Quantitation, 50, 52
Real-Time Status, 23
Run Information, 75
Study Analysis in Gene Study, 88, 90
Study Setup in Gene Study, 89
Time Status, 24

Target Name, 42
Targets

Experiment Settings, 44, 85
Reaction efficiency (E), 63

Technical
Notes, ii
Specialists, ii

Temperature
Step, 29

Temperature Control
Mode, 33

Temperature control
Block mode, 33
Mode, 33

Threshold
Adjusting, 54

Thresholds
Window, 54

Time Status tab, 24
Toolbar

Data analysis, 50
Main software, 12
Main window, 9
Plate Editor, 38, 39
Protocol Editor, 28

Trace
Adjusting, 62
Color, 62
Style, 62

U
Units, 39

USB
Connections, 3

W
Warning

Instruments, iii
Labels, iii
Labels, safety, iii
List in manual, ii
Risk of burning, iii
Risk of explosion, iii
Risk of harm, iii
Safety, iii

Well
Concentration, 42
Contents, 42
Fluorophores, 42
Groups, 40
Notes, 42, 44
Sample Name, 42
Sample Type, 42
Target Name, 42

Well groups, 46
Creating, 46
Data analysis, 46
Standard Curve, 46

Well Groups Manager, 40
Well Notes, 44
Well selector

Data analysis, 55
Window

Baseline, 54
Gene Study, 87
Plate Editor, 38
Protocol AutoWriter, 33
Protocol Editor, 27
Run Details, 21
Threshold, 54
Well Groups Manager, 40
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